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 Introduction 

The LeddarVu module enables developers and integrators to make the most of Leddar™ 
technology through integration in detection and ranging systems. The purpose of the LeddarVu 
module is to easily and rapidly be integrated in various applications. 

The module can be configured to be used in very simple applications or to perform more complex 
tasks depending on the hardware and software settings. 

1.1. Description 

The LeddarVu module contains the following: 

• Source and control assembly 

• Receiver assembly 

The module comes in two configurations:  

1. SPI  
2. USB, CAN and SERIAL  

Depending on your configuration, they offer the following features: 

• Horizontal field of view (FOV): 16°, 47.5° and 98.5°  

• Vertical field of view (FOV): 0.3°, 2.25° and 3°  

• 8 detection segments 

• Real-time data acquisition and display (through SPI) 

• SPI (Serial Peripheral Interface) for the direct link with the receiver (SPI carrier board) 

• I2C interface to read the optional temperature sensor on the source module (SPI carrier board) 

• Serial link interface: TTL, RS-232, RS-422, and RS-485 (USB, CAN and SERIAL carrier board) 

• USB interface (USB, CAN and SERIAL carrier board) 

• CAN bus interface for acquisition (USB, CAN and SERIAL carrier board) 
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Figure 1: General elements of the LeddarVu module 

 

Receiver assembly 

The receiver assembly contains the photodetector array (8 elements), the circuit receiver, and a 
processor (MCU). 

The module generates a full waveform per segment at its measurement rate. 

NOTE: Lens coating color for 47.5° configuration may change from one sample to another from 
greenish to bluish, but the inherent properties of the lens are not affected in the field of 
application of this product. 

Emitter assembly 

The emitter assembly includes the emitter (LED, VSCEL, or laser), the emitter driver circuit, and 
the temperature sensor. 

Light source pulsing is controlled by the receiver assembly since the receiver data acquisition must 
be synchronized with the light source pulses. The temperature sensor, located near the light 
source, is used to implement temperature compensation on the ranging results. 

Power connection 

The power connection is a 2-pin connector that provides the module with a 12 V power source. 

  



 

Page 13 of 129  54A0028-6 042019 © LeddarTech Inc. 

1.2. SPI Carrier Board 

The following presents the description of the SPI board. 

 

 

 

Figure 2: Board of the SPI LeddarVu module 

 

NOTE: Power outputs can supply up to 15 mA.  
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1.3. USB, CAN and SERIAL Carrier Board 

The following presents the description of the USB, CAN and SERIAL board. 

 

   

 

 

Figure 3: Board of the USB, CAN and SERIAL LeddarVu module 

 

NOTE: Power outputs can supply up to 15 mA. 
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DIP Switches  

The DIP switches are used for the configuration of the serial port number 1. This port is configurable 
to these EIA electrical interfaces for the following standard serial communication ports:  

• RS-232 

• RS-485 two-wire configuration 

• RS-422/RS-485 four-wire configuration 
 

Table 1: Communication port configuration (for 6 positions DIP switch) 

NOTE: On all port configurations, the module is still a half-duplex slave. 

 

Table 2: Communication port configuration (for 8-position DIP switch) 

Interface DIP switch position 

1 2 3 4 5 6 

RS-232 OFF OFF ON OFF OFF X 

RS-485 
 two-wire 

configuration 
ON ON OFF ON ON X 

RS-422 

RS-485 
four-wire 

configuration 

ON OFF ON OFF OFF X 

Interface DIP switch position 

1 2 3 4 5 6 7 8 

RS-232 OFF ON OFF OFF OFF X X X 

RS-485 
two-wire 

configuration 
ON OFF ON ON ON X X X 

RS-422 

RS-485 
four-wire 

configuration 

ON ON OFF OFF OFF X X X 
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NOTES: 

• DIP switch position 6 on ‘ON’ position enables a 121Ω termination resistor to RS-485 two-
wire configuration only (must be kept on ‘OFF’ position in any other configuration). 

• DIP switch position 8 on ‘ON’ position enables a 121Ω termination resistor to CAN port.  

 

Configurable serial link 1 

Depending on the DIP switch positions, the configurable serial link pin functionalities differ  
(refer to Table 3). 

 

Table 3: Communication link configuration 

Pin 
position 

Interface 

 RS-232 
RS-485 two-wire 

configuration 

RS-422 

RS-485 four-wire 
configuration 

1 GND GND GND 

3 RTS D - Dout - 

5 NC NC NC 

7 RX D - Din + 

9 TX D + Dout + 

11 CTS D - Din - 

 

NOTE: If a two-wire or four-wire differential port configuration is selected, in function of your network 
configuration, you should put bias resistors on transmitter or receiver lines to maintain the 
proper idle voltage and force the line to the idle condition. 

  



 

Page 17 of 129  54A0028-6 042019 © LeddarTech Inc. 

 

Push buttons 

The S1 push button is used for a hard-reset purpose; a short press resets the module. 

The S3 push button is used for special purposes (refer to Table 4).  

 

Table 4: S3 push button functionalities 

 

  

Description Action 

Long press during module 
operation (longer than 10 
seconds) 

Resets the carrier board configuration to the default values: 

CAN port configuration 

• 1Mbsp, standard frame format 

• Base Rx: 0x740 

• Base Tx: 0x750 

• No delay 

• Distance in cm and a max. of 96 echoes 
 

Serial link configuration 

• 115,200 bps, 8 bits, no parity, no flow control, 1 stop bit 

• Distance in cm and a max. of 40 echoes 

• Modbus address: 1 

Press the S3 button for 
more than 2 seconds 
during startup (or after a 
hard reset) 

Put the USB, CAN and SERIAL carrier board in bootloader mode. This 
feature is used to upgrade the USB, CAN and SERIAL carrier board 
firmware. 

Use the LeddarTech software tool to upgrade firmware. 
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1.4. Working Diagram 

The working diagram explains how the module works in the standard and optional configurations. 

 

Figure 4: LeddarVu module working diagram 
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1.4.1. SPI Carrier Board 

The SPI carrier board includes the following elements: 

SPI and control interface 

The SPI serial port functionalities are available via pins 3, 5, 7, and 9. The port has a standard 
signal level of 0 V through 3.3 V. 

Table 5: SPI pin definition 

Pin Function 

3 CLK (input) 

4 Hard-reset (input) 

5 MISO (output) 

7 MOSI (input) 

9 CS (input) 

I2C interface 

The integrated circuit (I2C) protocol is intended to allow multiple slave digital circuits to 
communicate with one or more master circuit. As for the SPI, it is only intended for short distance 
communications. The port has a standard signal level of 0 V through 3.3 V. 

Power supply 

The power source includes the source, the auxiliary DC output connection, the +12 V connection, 
the +5 V analog supply, and the +3.3 V supply.  
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1.4.2. USB, CAN and SERIAL Board 

The optional carrier board includes the standard elements and the following ones: 

 
Serial ports (TTL, RS-232, RS-422, and RS-485) 

The TTL port is used for the short-range transmission of data. The port has a standard signal level 
of 0 V through 3.3 V. 

The RS-232 is used for the transmission of data. It defines the signals connection between the data 
terminal equipment (such as a computer) and the data circuit-terminating equipment (such as a 
modem). 

The RS-422 (ANSI/TIA/EIA-422-B), a four-wire configuration, specifies the electrical characteristics 
of the digital signaling circuit. It can transmit data at rates as high as 10 Mbit/s or may be sent on 
cables as long as 1500 meters. Some systems directly interconnect and may be used to extend 
the range of an RS-232 connection. 

The RS-485 (ANSI/TIA/IEA-485) is a two-wire or four-wire differential serial communication port. It 
is often used in electrically noisy environments. 

 

Microcontroller MCU 

The source and control assembly are equipped with an MCU on the carrier board. It is provided to 
transmit data from the receiver module through the communication ports. 

 

USB interface 

The USB interface is a compatible 2.0, full-speed 12-MBit/s port. This interface emulates a VCP 
(virtual COM port) used as a serial port.  

 

Application and reset switch 
The reset switch restarts the module. This can be used as an alternative to cycling the power.  

 

Serial link configuration DIP switches 

The source and control assembly is equipped with ten DIP switches. Five of them are used to 
configure serial link 1 (see  
Figure 2 and  
Figure 3).  

 

CAN bus interface 

The CAN bus is implemented via a differential pair. The ISO 11898 standard describes the CAN 
technology. The interface has a level of 3.3 V. 
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 Underlying Principles 

Created by LeddarTech, LEDDAR™ (light-emitting diode detection and ranging) is a unique 
sensing technology based on light (infrared spectrum) and the time-of-flight of light principle. The 
light source illuminates the area of interest (pulsed typically at 10 kHz for the LeddarVu8 47.5° 
module) and the multichannel module receiver collects the backscatter of the emitted light and 
measures the time taken for the emitted light to return back to the module.  

An 8-channel photodetector array is used and provides multiple detection and ranging segments. 
Full-waveform analysis enables detection and distance measurement of multiple objects in each 
segment, provided that foreground objects do not fully obscure objects behind them. Oversampling 
and accumulation techniques are used to provide extended resolution and range. 

Figure 5 illustrates the illumination area and detection segments. In this case, the 8 segments 
provide a profile of the object in the beam. In other installations, the channels can be used to locate 
and track one or multiple objects in the beam. 

 

 

Figure 5: Illumination area and detection zone 

The core of Leddar™ sensing is the pulsing of diffused light, collection of reflected light (including 
oversampling and accumulation), and full-waveform analysis. The light source type, the number of 
light sources, the illumination and reception beam, and the number of photodetectors can all be 
tailored to fit specific application requirements such as detection range, beam, and spatial 
resolution. 
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 Getting Started 

This chapter presents the steps to install Leddar™ Configurator and start using the LeddarVu. 

3.1. Optional Power Supply 

The power supply included with the Starter Kit version of the LeddarVu8 has a pluggable terminal 

block that connects to the 12V header connector of the LeddarVu sensor. Location of the 12V 

header pin can be found on  

Figure 2 (LeddarVu SPI) or  

Figure 3 (LeddarVu USB, UART, CAN Bus). 

 

Figure 6: Optional Power Supply Terminal Block 
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3.2. Optional SPI cable 

 

The table below shows the pinout of the optional SPI cable sold by LeddarTech. Refer to  
Figure 2 for connection information. 

Table 6: Optional SPI Cable Pinout 

Wire Color Function 

Black Ground 

Blue Reset_N 

Orange SCLK 

Green MISO 

Yellow MOSI 

Brown CS# 

3.3. Setup 

This section presents the Leddar™ Configurator installation and the procedure to set up the 
LeddarVu module. All software operations are described in chapter 6. 

To install Leddar™ Configurator: 

1. Download the LeddarInstaller.exe file from our Web site at 
http://support.leddartech.com/login. 

a. If you are a new user, fill the form and click Submit. 

b. If you are a registered user, login by entering your e-mail address and password, 
and click Log In. 

2. In the Download section, click a product and then click LeddarInstaller.exe. Double-click 
the file to start the installation. 

3. On the computer desktop, double-click the Leddar™ Configurator icon. 

4. In the Welcome to the Leddar™ Software 3 Setup Wizard dialog box, click Next. 

http://support.leddartech.com/login
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Figure 7: Welcome to the Leddar™ Software 3 Setup Wizard dialog box 

 

In the End-User License Agreement dialog box, read the terms of the agreement, select the I 
accept the terms in the License Agreement check box, and click Next. 

 

Figure 8: End-User License Agreement dialog box 

 

In the Product Types dialog box, the Leddar™ Software Development Kit check box is selected 
by default. 
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Figure 9: Product Types dialog box 

1. Click Next. 

2. In the Destination Folder dialog box, click Next to select the default destination 
folder. 

OR 

Click the Change button to choose a destination folder. 

3. In the Ready to Install Leddar™ Software 3 dialog box, click the Install button. 

4. In the Completed the Leddar™ Software 3 Setup Wizard dialog box, click Finish. 

 

Leddar™ Configurator creates an icon on the computer desktop. 
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3.4. Connecting to the LeddarVu Module 

The first time the module is connected to a computer, a few seconds are required for Windows™ 
to detect it and complete the installation. 

Once the installation is completed, you can connect to the LeddarVu module to create your 
configuration. 

To connect to the module: 

1. Connect the power cable to the module and to a power source. 

2. Connect the USB cable to the module and to the computer. 

3. On the computer desktop, double-click the Leddar™ Configurator icon. 

4. In Leddar™ Configurator, click the connect button . 

 

Figure 10: Connecting to a module 

 

5. In the Connection dialog box, in the Select a connection type list, select either LeddarVu 
SPI for a standard board or LeddarVu Serial for an USB, CAN and SERIAL. 
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Figure 11: Connection dialog box 

6. In the Available ports list, select the product and click the Connect button. 
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The main window displays the detections (green lines) in the segments (white lines). 

 

Figure 12: Main window 

 

A complete description of Leddar™ Configurator features and parameters for the LeddarVu 
module can be found at chapter 6. 

 

NOTE: Refer to Section 6 LeddarTM Configurator for details on how to use the software. 
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 Measurements and Settings 

This chapter presents measurements, settings, and zone definition for the LeddarVu module. 

4.1. Distance Measurement 

Distance is measured from the base of the standoffs for the LeddarVu module. 

 

Figure 13: Distance measurement 

The dashed lines illustrate 1 of the 8 segments and the solid line indicates the distance measured 
by the module in that segment. 
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4.2. Data Description 

Data displayed in the Raw Detections dialog box allow the user to precisely define the desired 
detection parameters (View menu > Raw Detections). 

 

Figure 14: Raw Detections dialog box 

An object crossing the beam of the module is detected and measured. It is qualified by its distance, 
segment position, and amplitude. The quantity of light reflected back to the module by the object 
generates the amplitude. The bigger the reflection, the higher the amplitude will be. 

The amplitude is expressed in counts. A count is the unit value of the used ADC in the receiver. 
The fractional of counts is caused by the accumulation to get more precision. 

  



 

Page 31 of 129  54A0028-6 042019 © LeddarTech Inc. 

Table 7: Raw detection table description 

Field Description 

Segment (Seg) Beam segment in which the object is detected. 

Distance Position of the detected object. 

Amplitude Quantity of light reflected by the object and measured by the module. 

Flags 8-bit status (bit field). See Table 8. 

 

The Flag parameter provides the status information that indicates the measurement type. 

Table 8: Flag value description 

Bit position Bit = 0 Bit = 1 

0 Invalid measurement Valid measurement 

1 Normal measurement 
Measurement is the result of demerge 
processing 

2 Reserved Reserved 

3 Normal measurement 

Received signal is above the saturation level. 

Measurements are valid (VALID is set) but 
have a lower accuracy and precision. 

Consider decreasing the light source intensity. 

4 Reserved Reserved 

5 Reserved Reserved 

6 Reserved Reserved 

7 Reserved Reserved 
 

 

The Flag field provisions for 8 bits encoded as a bit field. Three bits are currently used. The 
following table presents the implemented decimal values of the status bit field. 

Table 9: Status value description 

Status value 
(decimal) 

Status value (binary) Description 

1 00000001 Normal measurement (valid) 

9 00001001 Saturated signal (valid) 
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4.3. Acquisition Settings 

Acquisition settings allow you to define parameters to use for detection. 

To open the Acquisition Settings dialog box, select Device > Configuration > Acquisition. 

4.3.1. General Settings 

 

Figure 15: General tab – Acquisition Settings dialog box 

To apply new acquisition settings, click .  
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Table 10: Acquisition settings description 

Parameter Description Range 

Accumulation 

Number of accumulations. 

 

Higher values enhance the range and reduce the 
measurement rate and noise. 

 

When you increase the accumulation value, you reduce the 
noise as well as the measurement rate. Depending on your 
application, a reduction of the noise might be more 
important than a high measurement rate.  

 

1 

2 

4 

8 

16 

32 

64 

128 

256 

512 
1024 

Oversampling 

Number of oversampling cycles. 

 

Higher values enhance the accuracy/precision/resolution 
and reduce the measurement rate. 

 

When you increase the accumulation value, you increase 
the resolution (accuracy) but you reduce the measurement 
rate. Depending on your application, a higher resolution 
might be more important than a high measurement rate.  

1 

2 

4 

8 
16 
32 

Points 

Number of base sample points. 

 

Determines the maximum detection range. The more 
points there are, the more they have an impact on the 
processing load since it impacts the number of sample 
points to process for each segment.  

2 to 128 
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Parameter Description Range 

Threshold 
Offset 

Modification to the amplitude threshold. 

Higher values decrease the sensitivity and reduce the 
range. 

 

See below for more details. 

−50.00 to 500.00 

Smoothing  

Object smoothing algorithm. Smooths the LeddarVu 
module measurements. 

The behavior of the smoothing algorithm can be adjusted 
by a value ranging from -16 to 16. Higher values enhance 
the module precision but reduce the module reactivity. 

The smoothing algorithm can be deactivated by clearing 
the Enable check box. 

The measurement smoothing algorithm is advised for 
application that need to measure slowly moving objects 
with a high precision. 

The application requiring to quickly track moving objects, 
the smoothing should be configured with a value lower than 
0 or simply deactivated. 

 

See below for more details. 

−16 to 16 

 

 

Light Source 
Control 

Light source power control options. 

Selects between manual and automatic power control. In 
automatic, light source power is adjusted according to 
incoming detection amplitudes.  

The current laser power level is visible in the  

View > State > Device State window.  

 

See below for more details. 

100% 

81% 
53% 
28% 
6% 

Change Delay 
(Channel and 
Frame) 

Minimum delay between power changes. 

 

Smaller numbers speed up the response time of the light 
source power adjustment. 

Channel: 

0 to 8 
 

Frame: Varies 

Saturation 
Compensation 

When selected, this parameter activates the advanced 
distance computation algorithm for very strong (saturated) 
signals. This computation uses slightly more computing 
power to enhance the quality of the distance 
measurements of saturated light pulses. 

N/A 

Static Noise 
Removal 

When selected, this parameter enhances measurements 
by subtracting the constant electronic noise present at the 

beginning of signals. 
N/A 

Overshoot 
Management 

When selected, this parameter improves the detection of 
false measurements caused by specific signal shapes. For 

example, this may occur when strongly reflecting objects 
are present in the field of view. 

 

 

N/A 
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Parameter Description Range 

Crosstalk 
Removal  

Inter-segment interference noise removal. 

 

Crosstalk is a phenomenon inherent to all multiple 
segments time-of-flight sensors. It causes a degradation of 
the distance measurement accuracy of an object when one 
or more objects with significantly higher reflectivity are 
detected in other segments at a similar distance. 

This option enables an algorithm to compensate the 
degradation due to crosstalk. 

 

This algorithm increases the computational load of the 
LeddarVu module microcontroller. It is recommended to 
disable the crosstalk removal if the module is configured to 
run at rates higher than 50 Hz. 

N/A 

Crosstalk 
Echo Removal 

When selected, this parameter can further increase 
accuracy by removing secondary echoes that might still be 
present in adjacent segments after applying the first stage 
of crosstalk removal. 

N/A 

Object 
demerging 

Eases the discrimination of multiple objects in the same 
segment.  
 
Object demerging is only available for measurement rates 
under 5.0 Hz. Also, the accumulation value must be of 64 
and the oversampling value of 8. 
The number of merged pulses that can be processed in 
each frame is also limited. A status field is available in the 
device state window (LeddarTM Configurator) indicating if 
the sensor processes all merged pulses.  

The measurement of demerged objects tends to be less 
precise than for usual detections.  

 

See below for more details. 

N/A 
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Threshold offset 

The threshold offset is a value that modifies the detection amplitude threshold.  

A default detection threshold table was determined to provide robust detection and minimize false 
detections caused by noise in the input signal. 

Figure 16 below presents the threshold table for a light source intensity of 16. This table is 

effective when the threshold offset value is 0.  

 

Figure 16: Detection threshold example 

The multiple lines on each graph present the thresholds for numbers of accumulations of 1 (top 
curve), 2, 4, 8, 16, 32, 64, 128, and 256 (bottom curve). Accumulations of 512 and 1024 are also 
available, although not shown (provide the lowest thresholds). 

 

The threshold offset parameter has the effect of offsetting each value in the threshold table by the 
selected value. This provides a means of reducing the sensitivity (positive value) or increasing the 
sensitivity (negative value) of the module. Increasing the value of the threshold offset allows 
ignoring (will not result in a measurement) signals with amplitude higher than the default threshold. 
Decreasing the value of the threshold offset allows measurements of amplitude signals lower than 
the default threshold.  

 

NOTE: The default setting (0) is selected to ensure a very low occurrence of false measurements. 

False measurements are likely to occur when reducing the threshold offset (negative values). 

These false measurements are very random in occurrence while true measurements will be 

repeatable. For this reason, it may be useful in some applications to use a higher sensitivity and 
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filter out the false measurements at the application level. For example, this can be useful in 

applications that require long detection ranges or detection of small or low reflectivity targets. 

Smoothing 

The smoothing algorithm increases the precision of the measurement at the cost of the LeddarVu 
module reactivity. The history length of the filter is defined as a function of the measurement noise 
level. It also changes according to the oversampling and accumulation settings. 

The history length of the averaging filter can also be adjusted by a parameter ranging from −16 to 
16. Clear the Enable check box to disable smoothing. Higher values increase the module precision 
but reduce the module reactivity. An example of the behavior of the measurement smoothing 
algorithm is depicted in Figure 17.  

 

Figure 17: Measurement smoothing example 

The red line represents the true target distance; the blue curve corresponds to the target distance 
measured by the module without smoothing, while the green curve is the smoothed measurements. 
One could notice the measurement precision (standard deviation) is dramatically improved by the 
smoothing algorithm. 

NOTE: The smoothing algorithm is recommended for applications that need highly precise 

measurements of slowly moving objects. For application that tracks quickly moving objects, it is 

advised to decrease the value of the smoothing parameter or to disable the smoothing algorithm.  
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Light Source Control 

There is a total of 5 light source power levels. Their approximate relative power is evenly distributed 
between 0 through 100%. There were three power control mode: manual, automatic mode 1 and 
automatic mode 2.  

With the manual mode, the light power source of the sensor is set to a fixed value. This mode can 
be used in a controlled environment of sensor FOV. 

 
For automatic mode, the change delay defines the number of measurements required before 
allowing the LeddarVu module to increase or decrease by one the light source power level. For 
example, with the same change delay, the maximum rate of change (per second) of the light source 
power will two times higher at 12.5 Hz than at 6.25 Hz. The change delay can be set by the number 
of detection frame and the number of channel in saturation mode can be tolerated (automatic mode 
1 only). 
 
NOTE: Since the change delay parameter is a number of measurements, the delay will vary if the 
measurement rate is changed (through modification of the accumulation and oversampling 
parameters). 
 
Keeping the module in automatic light source power mode (default setting) ensures it adapts to 
varying environments. Close range objects may reflect so much light they can saturate the module, 
reducing the quality of the measurements. The automatic mode 1, will adapt the light output within 
the change delay setting (channel and frame parameter) to reach the optimal amplitude. On the 
other hand, low amplitudes provide lower accuracy and precision.  

This automatic light source power mode will select a light source intensity that provides the highest 
intensity that avoids the saturation condition. The automatic mode 2, will adapt the light output 
within the change delay (frame parameter only) to reach at least one or more channels in saturation 
condition to provides the highest detection range. This mode is useful to keep a highest detection 
range into non-saturated channels when a strongly reflective object is detected.  
 

NOTE: When a strongly reflective or near object is present in the field of view while monitoring 
farther distances, the automatic adjustment mode 1 will reduce the effective range of the module 
(reduce light source intensity) and may prevent detection of long range or low reflectivity objects. 
For these applications, the automatic mode 2 may be a better setting. 
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Object Demerging 

The sensor can detect up to 4 objects per channel, as long as there is enough infrared light coming 

back from each target. There is also the possibility to activate the Active Demerging which will allow 

to demerge one pair of objects which closer together than normal. With the active demerging 

enabled, the sensor can also detect up to 4 objects per channel with the advantage of having 2 of 

these 4 objects to be detected while being close to each other.   

 
When the Active demerging is disabled. 
 

▪ The normal demerging will happen on any objects who are separated by at least 5 meters. 
This normal feature can give up to 4 detections. 

 

When the Active demerging is enabled, the normal demerging will still occur in addition to demerge 
a pair of objects which are significantly closer together 
 

▪ The Accumulation needs to be of 64 and higher for the active demerging to be ON 
▪ The Oversampling need to be of 8 and higher for the active demerging to be ON 
▪ At 8 Oversampling the demerging will happen if the two objects are separated by 90cm 
▪ At 16 Oversampling the demerging will happen if the two objects are separated by 70cm 
▪ At 32 Oversampling the demerging will happen if the two objects are separated by 50cm 
▪ The accuracy of the sensor can be slightly altered on these two objects. 

 

The active demerging will not work if one of the targets has an amplitude which is 10 times higher 
than the other target that is to demerge. 
 
The minimum amplitude for targets to be demerged is of 10 counts each. There cannot be any 
demerging if the detection is saturated. 

If the targets cannot be demerged (from normal demerging or active demerging) i.e. if they are 

closer than the minimum distance required if they do not meet the minimum or maximum amplitude 

requirement, the two detections will be averaged as only one detection. This average will be 

weighted by the amplitude and the range of the given detections. 
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4.3.2. Enabling and Disabling Segments 

To open the Acquisition Settings dialog box, select Device > Configuration > Acquisition. 

Segments are enabled by default. Deactivating a segment can target what needs to be identified 

in a field of view. This has an impact on the measurement rate which will be faster. 

 

Figure 18: Segments tab – Acquisition Settings dialog box 

When you uncheck segments, the corresponding segments will appear with gray square lines in 

the main window as shown in the image below. 
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Figure 19: Disabled segments example 

 

To apply new acquisition settings, click the apply button  in the main window. 
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4.4. Measurement Rate 

The LeddarVu module acquires a base input waveform for all segments at a rate between 10 kHz 
and 40 kHz, depending on the sensor field of view (see Table 11).  

Multiple acquisitions are used to perform accumulations and oversampling and generate a final 
waveform that is then processed to detect the presence of objects and measure their position. 

 

Table 11: Base Acquisition Rate Based on the Field of View 

LeddarVu8 FOV Base Acquisition Rate 

16° 10 kHz 

47.5° 20 kHz 

98.5° 40 kHz 

 

Therefore, the final measurement rate is: 

 

𝑀𝑒𝑎𝑠𝑢𝑟𝑒𝑚𝑒𝑛𝑡 𝑟𝑎𝑡𝑒 =  
𝐵𝑎𝑠𝑒 𝑅𝑎𝑡𝑒

(𝑁𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑠𝑒𝑔𝑚𝑒𝑛𝑡𝑠 𝑒𝑛𝑎𝑏𝑙𝑒𝑑 + 1) ∗ 𝑎𝑐𝑐𝑢𝑚𝑢𝑙𝑎𝑡𝑖𝑜𝑛𝑠 ∗ 𝑜𝑣𝑒𝑟𝑠𝑎𝑚𝑝𝑙𝑖𝑛𝑔
 

 

 

 

For example, LeddarVu 16° with 256 accumulations and an oversampling value of 8: 
 

𝑀𝑒𝑎𝑠𝑢𝑟𝑒𝑚𝑒𝑛𝑡 𝑟𝑎𝑡𝑒 =  
10000

(8 + 1) ∗ 256 ∗ 8
= 0.5425 Hz 

 

Table 12 below presents the measurement rate for typical values of accumulations and 

oversampling. 
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Table 12: Measurement rate for LeddarVu8 
 

Accumulation Oversampling Measurement Rate (Hz) 

  
LeddarVu 

16° 
LeddarVu 

47.5° 
LeddarVu 

98.5° 

1024 8 0.1356 0.2713 0.5425 

512 8 0.2713 0.5425 1.0851 

256 8 0.5425 1.0851 2.1701 

128 8 1.0851 2.1701 4.3403 

64 8 2.1701 4.3403 8.6806 

32 8 4.3403 8.6806 17.3611 

1024 4 0.2713 0.5425 1.0851 

512 4 0.5425 1.0851 2.1701 

256 4 1.0851 2.1701 4.3403 

128 4 2.1701 4.3403 8.6806 

64 4 4.3403 8.6806 17.3611 

32 4 8.6806 17.3611 34.7222 
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4.5. CPU Load 

The measurement rate varies with the accumulations and oversampling settings. The higher the 
rate, the higher the processing load is on the source and control assembly microcontroller. The 
Point parameter, in the Acquisition Settings dialog box, (Device menu, Configuration > 
Acquisition) also has an impact on the processing load since it impacts the number of sample 
points to process for each segment. 

Given the high flexibility of parameter settings, it is possible to create a processing load that 
exceeds the capacity of the microcontroller. When the microcontroller load is exceeded, the 
theoretical measurement rate will not be obtained. 

The load (CPU Load) is displayed in the Device State window (View menu > State). It is 
recommended to verify the load when modifying the accumulations, oversampling, and point count 
parameters. The measurement rate will be lower than the calculated rate and the measurement 
period may be irregular when the load nears or reaches 100%. 

 

Figure 20: Device State window 
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 Communication Interfaces 

The interfaces and links are optional and are implemented depending on your configuration. 

5.1. SPI Interface 

The SPI interface on the SPI board is a direct link to the receiver module. 

The SPI interface available with the USB, CAN and SERIAL board is a port connected to MCU but 
not implemented for the moment. 

5.1.1. SPI Basics 

The SPI interface uses the configuration mode 0; where, data is captured on the rising edge of the 
clock signal and outputted on the falling. 
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Figure 21: Standard SPI timing diagram 

 

Table 13 below presents the basic clock signal modes. 
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Table 13: Basic modes 

Mode 
Clock Polarity 

CPOL 
Clock Phase 

CPHA 

0 0 0 

1 0 1 

2 1 0 

3 1 1 

 

5.1.2. SPI Protocol 

The universal SPI protocol uses a combination of standard commands for FLASH and SRAM 
memories. 

Each SPI packet contains a header, a payload, and a cyclic redundancy check (CRC).  

The first byte of the header corresponds to an instruction opcode. It is followed by a 24-bit address 
and the 16-bit size of the payload. The payload contains several user-data bytes. The last 16 bits 
of the packet is the CRC16 (IBM) of both header and payload. The table below summarizes the 
structure of an SPI packet. It is noted that address and the CRC are packed with the most significant 
byte first while the first byte of data corresponds to the least significant byte. 

Table 14: Byte offsets 

Field Opcode Address Size Data CRC16 

Byte 
offset 

1 2 3 4 5 6 7 … 7 + n 8 + n 9 + n 
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The supported opcodes are presented in Table 15. 

Table 15: SPI opcode commands 

Mnemonic Opcode Operation Description 

READ 0x0B Read data 

The read command returns data from 
memory starting at the selected address. It 
needs a delay between the group containing 
the opcode, address, and size data, and the 
return data stream to let the receiver module 
to decode the request and get the ready data 
to the clock. 

WRITE 0x02 Write data 
The write command writes data to memory 
starting at the selected address and is limited 
to a page of 1 to 512 bytes. 

CE 0xC7 
Reset 

configuration 

The reset command resets the module to the 
default configuration. The process is started 
on deassert of nCS and the write-enable flag 
in the status register must be asserted. 

RDSR 0x05 
Read status 

register 

The read status command returns a byte of 
the status register and bit-field flags (refer to 
Table 16). 

WREN 0x06 Write enabled 
The write enabled command disables the 
write protection in order to modify any 
parameters. 

WRDIS 0x04 Write disabled 
The write disabled command enables the 
write protection to lock the module from any 
parameter changes. 

SOFTRST 0x99 Software reset 
The software reset command resets the 
receiver module. 
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The status register and bit flags are presented in Table 16. 

Table 16: Status register 

Bit Name Access Description 

7:2 Reserved R/W Future use 

1 
Write enable 
latch 

R 
0 = Write disabled 

1 = Write enabled 

0 Module ready R 
0 = Module ready 

1 = Module busy (programming, erasing) 

 

 

Data chronograms are represented in Figure 22 and Figure 23, and opcode and register 
chronograms are presented in Figure 24 and Figure 25 below. 
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5.1.3. Memory Map 

The memory map is divided in four memory banks. This section presents the description of the four 
memory banks in a table format. 

Table 17: Memory banks 

Bank 
Number 

Start Base 
Address 

Bank Size 
(KB) 

Access Description 

0 0x00000000 1024 R/W Configuration data 

2 0x00200000 512 R/W Configuration data 

6 0x00400000 128 
Read only General device information and 

constants 

10 0x00480000 128 R/W General Status 

12 0x004C0000 128 R/W LeddarVu Status 

14 0x00500000 1024 Read only Detection list 

21 0x00FFFB00 1 R/W Transaction configuration 

 

Configuration Data 

Table 18: Configuration data bank 

Offset Length Type Description 

0 32 char Module name as an ASCII string 

32 1 uint8_t 
Accumulation exponent: for example, 3 = 
23=8 

33 1 uint8_t 
Oversampling exponent: for example, 3 = 
23=8 

34 1 uint8_t Base point sample 

35 4 uint32_t Bit field of segment enabled 

39 4 uint32_t Acquisition rate of the reference pulse 

43 4 float Yaw angle of the module 

47 4 float Pitch angle of the module 

51 4 float Roll angle of the module 

55 4 float X-axis position of the module 

59 4 float Y-axis position of the module 

63 4 float Z-axis position of the module 
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Offset Length Type Description 

67 1 int8_t 

Precision (smoothing): Stabilizes the module 
measurements. The behavior of the 
smoothing algorithm can be adjusted by a 
value ranging from –16 through 16.  

68 1 uint8_t Precision enabled 

69 1 uint8_t Saturation compensation enabled 

70 1 uint8_t Overshoot management enabled 

71 4 int32_t 
Sensitivity (detection threshold) setting 
expressed in a raw amplitude scale. 

75 1 uint8_t Light source power (0 to 100) 

76 1 uint8_t 

Auto light source power: 

0: disabled 

1: mode 1 

2: mode 2 

77 2 uint16_t 

Auto frame average: Changes the delay in 
the number of measurements. This is the 
responsivity of the auto light source power 
according to the number of frames. 

79 1 uint8_t 

Auto detections average: Number of 
detections for saturation acceptance (the 
number of detections can be saturated to 
avoid decreasing the light source power 
when using the automatic mode). This is the 
responsivity of the auto light source power 
according to the number of detections. 

80 1 uint8_t Object demerging enabled 

81 1 uint8_t Static noise removal enabled 

 

Product Configuration 

Table 19: Product Configuration Data Bank 

Offset Length Type Description 

0 1 uint8_t  Crosstalk Removal enabled 

1 1 uint8_t  Crosstalk Echo Removal enabled 
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Device Information and Constants 

Table 20: Device information and constants bank 

Offset Length Type Description 

0 32 char Module part number as an ASCII string 

32 32 char Software part number as an ASCII string 

64 32 char Module serial number as an ASCII string 

96 32 char Manufacturer name as an ASCII string 

128 32 char Group identification number as an ASCII string 

160 32 char Build date as an ASCII string 

192 32 char Firmware version as an ASCII string 

224 32 char Bootloader version as an ASCII string 

256 32 char 
ASIC version as an ASCII string (optionally filled in 
function of the module) 

288 32 char FPGA version as an ASCII string 
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Offset Length Type Description 

320 2 uint16_t 

Module type 

0x00000000: Invalid Device 

0x00000007: M16 Evaluation Kit 

0x00000008: IS16 

0x00000009: M16 

0x0000000A: LeddarOne 

0x0000000D: LeddarVu8 

322 4 uint32_t Internal Use 

326 1 uint8_t Accumulation exponent min. 

327 1 uint8_t Accumulation exponent max. 

328 1 uint8_t Oversampling exponent min. 

329 1 uint8_t Oversampling exponent max. 

330 1 uint8_t Base point sample min. 

331 1 uint8_t Base point sample max. 

332 2 uint16_t Number of vertical segments 

334 2 uint16_t Number of horizontal segments 

336 2 uint16_t Number of reference segments 

338 4 uint32_t Base point sample distance 

342 4 uint32_t 
Reference segment mask: bit-field mask indicates 
the position of the reference segments. 

346 2 uint16_t Number of sample max. 

348 1 uint8_t Internal Use 

349 4 uint32_t Clock frequency 

353 1 uint8_t Maximum number of detections per segment 

354 4 uint32_t Distance scale 

358 1 uint8_t 
Raw amplitude scale bit, to which 0xd must be 
added (amplitude scale given in bitshift). That is 
raw amplitude << (scale bit + 0x0d) 

359 4 uint32_t 
Raw amplitude scale, to which the value 8192 
must be added. 

363 2 int16_t Precision min. 

365 2 int16_t Precision max. 

367 4 int32_t Sensitivity min. 

371 4 int32_t Sensitivity max. 

375 1 uint8_t Current light source power count (max 16) 

376 2 uint16_t Auto frame average min. 
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Offset Length Type Description 

378 2 uint16_t Auto frame average max. 

380 1 uint8_t Auto light source power percent min. 

381 1 uint8_t Auto light source power percent max. 

382 1 uint8_t Auto detections average min. 

383 1 uint8_t Auto detections average max. 

384 1 uint8_t 

Static noise calibration source: 

0 = By end-user 

1 = By factory 

385 4 uint32_t CPU load scale 

389 4 uint32_t Temperature scale 

LeddarVu Device Information and Constants 

Table 21: Device Information and Constants 

Offset Length Type Description 

0 1 uint8_t 
Sensor temperature scale exponent 
Sensor temperature scale = 2^ contents of this 
register 

 

General Status 

Table 22: General Status 

Offset Length Type Description 

0 1 uint8_t 
Detection ready flag: for polling mode, detections 
are ready to read if set to 1 

37 4 uint32_t 

CPU Load 
 
%CPU load = Contents of this register/CPU load 
scale 

75 4 uint32_t Binary CRC32 

LeddarVu Status 

Table 23: General Status 

Offset Length Type Description 

0 4 uint32_t 

Sensor temperature 

Temperature = Contents of this register/(2^ sensor 
temperature scale exponent) 
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Detection List 

Table 24: Detection list bank 

Offset Length Type Description 

0 4 uint32_t Timestamp: in ms since the power up 

4 2 uint16_t Number of detection (N) 

6 2 uint16_t Current percentage of light source power 

8 4 uint32_t Acquisition options 

12 

N * 
detection 
structure 

size 

Array of detection 
structure 

Start of detection list array 

Refer to Table 25 for details. 

 

 

Detection Structure Size 

Table 25: Detection structure size 

Offset Length Type Description 

0 4 uint32_t 

Distance expressed in distance scale 

To convert to meters, the distance must be 
divided by the distance scale. 

4 4 uint32_t 

Amplitude expressed in raw amplitude scale 

To convert the amplitude to count, it must be 
divided by the amplitude scale. 

Amplitude = Contents of this 
register/(Amplitude Scale Register + 8192) 

8 2 uint16_t Segment number 

10 2 uint16_t 

Bit-field detection flags: 

Bit 0: Detection is valid (will always be set) 

Bit 1: Detection is the result of object 
demerging 

Bit 2: Reserved 

Bit 3: Detection is saturated 

Bit 4: Reserved 

Bit 5: Reserved 

Bit 6: Detection is within the crosstalk zone 

Bit 7: Reserved 
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Transaction Configuration 

Table 26: Transaction configuration bank 

Offset Length Type Description 

0 1 uint8_t 

Secure-transaction enabled flags: 

1 = Enables the CRC calculation and validation on any 
transaction. This flag is enabled by default. 

0 = No CRC validation. The CRC field is still required in SPI 
protocol but can be set to any value. 

1 1 uint8_t 

Transaction modes: 

0 = Free run. The READY pin is asserted on each ready 
detection frame. The host must be able to read data on time. 

1 = Blocking read. On the READY pin assertion, host must 
read all data from traces or detections bank (data transaction 
control source configuration) to continue acquisition. 

2 = Partial blocking read. On the READY pin assertion, host 
can read all data from traces of the detection bank and the 
acquisition is still running. Possible loss of detection frames 
if the host reading data is very long. 

2 2 uint16_t CRC of the last transaction 

4 2 uint16_t 

Bit-field information of last transactions: 

• All bits to 0: No transaction error 

• Bit-0: Access right violation 

• Bit-1: Invalid address 

• Bit-2: Command not found 

• Bit-3: Write disabled 

• Bit-4: CRC failed 

• Bit-5: Command execution error 

• Bit-6: Invalid packet 

6 1 uint8_t 

Data transaction control source: 

0 = On trace 

1 = On detections 

This register determines which data type will control the 
READY pin and manage the transaction mode. 

  



 

Page 57 of 129  54A0028-6 042019 © LeddarTech Inc. 

5.1.4. SPI Operation 

The SPI operation includes four parameters: SPI port configuration, speed and timing, access, and 
modification. 

5.1.4.1. SPI Port Configuration 

The SPI port must be configured in the 0 mode (see section 5.1.1 SPI Basics 45) to communicate 
with the receiver module.  

5.1.4.2. Sensor Hard Reset  

A hard-reset pin is available to reboot the sensor. The standard hard reset chronogram is shown 
on Figure 26 below: the nCS must not be asserted during this reset sequence. The minimum reset 
state time (Trst) is 1 millisecond. The minimum wait time after reset state release (Twait) is 
100 milliseconds.  

 

Figure 26: Standard hard reset chronogram 

To prevent the receiver module to go into the bootloader mode, the port must never have all SPI 
input pins (nCS, MOSI and CLK) set to the low level for more than 100 milliseconds at power up or 
when performing a hard reset. 

5.1.4.3. Speed and timing 

For the read operation, a delay is needed between the header (group containing the opcode, 

address, and size data), and the return data stream to let the receiver module to decode the request 

and get the ready data to the clock. This delay can be set to 1 millisecond, during this delay, the 

SPI clock must be halted and the nCS must be staying asserted (see Figure 22). 
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The SPI clock frequency can be in the range between 500 kHz and 25 MHz. 

5.1.4.4. Access 

To access a parameter, you need to add a parameter offset to the associated bank start base 
address. Use the parameter length to get or set the whole parameter field. 

5.1.4.5. Modification 

To modify a parameter: 

1. Disable the write protection of the module by sending the write enabled command. 

2. Poll the status register to get the ready state and write enabled flag asserted. 

3. Send the new parameter value. 

4. Poll the status register to get the ready state. 

5. Send the write disabled command (write protection) to prevent any unwanted parameter 
change. 

NOTE: To prevent any data corruption or loss after modifying a parameter or a firmware update, 
the module must be in the ready state before shutting it down or doing a hard reset. 

5.2. I2C Interface 

The I2C interface on the SPI board is a direct link to the receiver and source modules. For the 
moment, only the temperature sensor is accessible. Refer to the LM75BIMM-3/NOPB temperature 
sensor datasheet from Texas Instruments. 

The I2C interface available with the enhance board is a port connected to MCU but not implemented 
for the moment. 

5.3. USB Interface 

The USB interface available with the USB, CAN and SERIAL board is a VCP (virtual COM port) 

serial emulation port. This port is used as a serial link with the Modbus protocol (refer to Section 

5.4 Serial Link Interface). This interface can also be used to update the USB, CAN and SERIAL 

board firmware in the bootloader mode. 

5.4. Serial Link Interface 

The serial links can be of the following electric signals: TTL, RS-232, RS-422, and RS­485. 

The serial link ports use the Modbus protocol using the RTU transmission mode only. This section 
describes the commands that are implemented. 

For more information on the Modbus protocol, please visit www.modbus.org. 

Read input register (function code 0x4) 

The following table presents the registers for the read input commands. 

http://www.modbus.org/
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Table 27: Read input register messages 

 

Address Description 

1 

Detection status for polling mode: 

0 = Detections not ready 

1 = Detections ready: this status flag is reset to 0 after reading this 
register 

2 Number of segments (N) 

11 Number of detections 

12 Current percentage of light source power 

13 Bit field of acquisition status: Reserved 

14 
Low 16 bits of timestamp (number of milliseconds since the module was 
started) 

15 High 16 bits of timestamp 

16 to 
16 + N-1 

Distance of first detection for each segment, zero if no detection in a 
segment. The distance unit is defined by the serial port parameters. 

16 + N to 
16 + (2*N) - 1 

Amplitude of first detection for each segment times 64 (that is, 
amplitude = this register/64), zero if no detection in a segment 

16 + (2*N) to 
16 + (3*N) - 1 

Flag of the first detection for each segment: 

Bit 0: Detection is valid (will always be set) 

Bit 1: Detection is the result of object demerging 

Bit 2: Reserved 

Bit 3: Detection is saturated 

Bit 4: Reserved 

Bit 5: Reserved 

Bit 6: Detection is within the crosstalk zone 

Bit 7: Reserved 

16 + (3*N) to 
16 + (4*N) - 1 

Distance of the second detection for each segment 

16 + (4*N) to 
16 + (5*N) - 1 

Amplitude of the second detection for each segment 

16 + (5*N) to 
16 + (6*N) - 1 

Flag of the second detection for each segment 

16 + (6*N) to 
16 + (7*N) - 1 

Distance of the third detection 

16 + (7*N) to 
16 + (8*N) - 1 

Amplitude of the third detection 

16 + (8*N) to 
16 + (9*N) - 1 

Flag of the third detection 
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Address Description 

16 + (9*N) to 
16 + (10*N) - 1 

Distance of the fourth detection 

16 + (10*N) to 
16 + (11*N) - 1 

Amplitude of the fourth detection 

16 + (11*N) to 
16 + (12*N) - 1 

Flag of the fourth detection 

16 + (12*N) to 
16 + (13*N) - 1 

Distance of fifth detection 

16 + (13*N) to 
16 + (14*N) - 1 

Amplitude of fifth detection 

16 + (14*N) to 
16 + (15*N) - 1 

Flag of the fifth detection 

16 + (15*N) to 
16 + (16*N) - 1 

Distance of the sixth detection 

16 + (16*N) to 
16 + (17*N) - 1 

Amplitude of the sixth detection 

16 + (17*N) to 
16 + (18*N) - 1 

Flag of the sixth detection 

NOTE: As per the Modbus protocol, register values are returned in big­endian format. 

For an example of a 0x04 Modbus function (read input register), refer to Appendix A. 

Read holding register (function code 0x3), write register (function code 0x6), write multiple 

register (function code 0x10), and read/write multiple register (function code 0x17). 

 

The following table presents the registers for these commands (see section 4.3 for a more detailed 

description of parameters).  

 Table 28: Read holding register message definition 

Address Description 

0 
Exponent for the number of accumulations (that is, if the content of this register 
is n, 2n accumulations are performed) 

1 
Exponent for the number of oversamplings (that is, if the content of this register 
is n, 2n oversamplings are performed) 

2 Number of base samples 

3 Reserved 

4 
Detection threshold as a fixed-point value with a 6-bit fractional part (that is 
threshold value is this register divided by 64). 
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Address Description 

5 

Light source power in percentage of the maximum. A value above 100 is 
an error. If a value is specified that is not one of the pre-defined values, 
the closest pre-defined value will be used. Refer to the detection reading 
to verify the LED intensity value as seen in Table 27 and Table 31. 

6 

Bit field of acquisition options: 

Bit-0: Automatic light source power enabled 

Bit-1: Demerge object enabled 

Bit-2: Static noise removal enabled 

Bit-3: Precision (smoothing) enabled 

Bit-4: Saturation compensation enabled 

Bit-5: Overshoot management enabled 

Bit-6: Automatic light source power mode: 

0: Mode 1 

1: Mode 2 

Bit-7: Crosstalk Removal enabled 

Bit-8: Crosstalk Echo Removal enabled 

7 Auto light source power change delay in number of measurements 

8 Reserved 

9 
Number of echoes for saturation acceptance: The number of echoes can 
be saturated to avoid decreasing the light source power in automatic 
mode. 

10 

Operation mode  

Write mode: 

0: Stop (stop acquisition) 

1: Continuous 

2: Single (acquisition of a single detection frame) 

Read mode: 

10: Stopped (sensor is stopped) 

11: Continuous acquisition mode 

12: Single frame busy (acquisition in progress) 

13: Sensor is busy 

11 
Smoothing: Stabilizes the module measurements. The behavior of the 
smoothing algorithm can be adjusted by a value ranging from –16 through 
16.  

12 Low 16 bits of segment enabled: Bit-field of enabled segment 

13 High 16 bits of segment enabled 
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NOTE: As per the Modbus protocol, register values are returned in big-endian format. 

A request for a register that does not exist will return error code 2. Trying to set a register to an 
invalid value will return error code 3. If an error occurs while trying to execute the function, error 
code 4 will be returned. 
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Report server ID (function code 0x11) 

This function returns information on the LeddarVu module in the following format:  

Table 29: Report server ID messages 

Offset Length Description 

0 1 
Number of bytes of information (excluding this one). Currently 0x99 
since the size of information returned is fixed. 

1 32 Serial number as an ASCII string 

33 1 
Run status 0: OFF, 0xFF: ON. Should always return 0 FF, otherwise 
the module is defective. 

34 32 The device name as an ASCII string 

66 32 The hardware part number as an ASCII string 

98 32 The software part number as an ASCII string 

130 8 The full firmware version as 4 16-bit values 

138 48 The full bootloader version as 4 16-bit values 

146 2 The FPGA­build version 

148 4 Internal Use 

152 2 Module identification code (13 for LeddarVu8) 

 

Get detections (function code 0x41) 

This function returns the detections/measurements in the following format: 

The first byte is the number of detections in the message. Because of the limitation on a Modbus 
message length, a maximum of 40 detections will be returned. 

NOTE: This maximum can be configured to a lower value using the Leddar™ Configurator   
software (serial port configuration) or the Write Register command described below. 

Following the first byte, each detection has six bytes (refer to Table 30). 
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Table 30: Get detection messages (detection fields) 

Offset Length Description 

0 2 
The distance (little-endian). Distance unit is defined by serial port 
parameters  

2 2 The amplitude times 64 [that is, amplitude = this field/64 (little-endian)] 

4 1 

4 bits are flags describing the measurement (all others are reserved): 

Bit 0 - Detection is valid (will always be set) 

Bit 1 - Detection is the result of object demerging 

Bit 3 - Detection is saturated 

Bit 6 - Detection is within the crosstalk zone 

5 1 Segment number 

Three more data fields follow the detection list: 

Table 31: Get detection messages (trailing fields) 

Offset Length Description 

0 4 
Timestamp of the acquisition (little-endian). The timestamp is expressed 
as the number of milliseconds since the device was started. 

4 1 Current light source power as a percentage of maximum. 

5 2 Bit-field acquisition. Reserved 

For an example of a 0x41 Modbus function, refer to Appendix B. 
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Read module data (function code 0x42) 

Table 32 and Table 33 present the request and answer codes for reading data. This function is an 
encapsulation of the SPI protocol. See section 5.1.3 Memory Map. 

Table 32: Requests 

Offset Length Description 

0 4 Base address: 0x00000000 to 0x00FFFFFF (little-endian) 

4 1 Number of bytes to read: 1 through 247 

 

Table 33: Answers 

Offset Length Description 

0 4 Base address: 0x00000000 to 0x00FFFFFF (little-endian) 

4 1 Number of bytes read: 1 through 247 

5 Nb * 1 byte Data 

Write module data (function code 0x43) 

Table 34 and Table 35 present the request and answer codes for writing data. This function is an 
encapsulation of the SPI protocol. See section 5.1.3 Memory Map. 

 

Table 34: Requests 

Offset Length Description 

0 4 Base address: 0x00000000 to 0x00FFFFFF 

4 1 Number of bytes written: 1 through 247 

5 Nb * 1 byte Data 

 

Table 35: Answers 

Offset Length Description 

0 4 Base address: 0x00000000 to 0x00FFFFFF 

4 1 Number of bytes written: 1 through 247 

Send opcode command (function code 0x44) 

Table 36 and Table 37 present the request and answer codes for sending the opcode. This function 
is an encapsulation of the SPI protocol. See section 5.1.3 Memory Map. 
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Table 36: Requests 

Offset Length Description 

0 1 

Opcode, supported opcodes: 

Read status = 0x05 

Write enabled = 0x06 

Write disabled = 0x04 

Reset configuration = 0x C7 

Soft reset = 0x99 

1 1 Argument: optional value (must be set to 0x00) 

 

Table 37: Answers 

Offset Length Description 

0 1 Opcode 

1 1 
Return value: optional return value (read status opcode = 
Status value) 
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Get serial port settings (function code 0x45, 0x00) 

Table 38, Table 39, and Table 40 present the requests and answers of the get serial port settings. 

Table 38: Requests 

Offset Length Description 

0 1 Sub-function code: 0x00 

 

Table 39: Answers header field 

Offset Length Description 

0 1 Sub-function code: 0x00 

1 1 Number of serial port 

2 1 
Current logical serial port number (current logical serial number 
connected to the host used for this transaction) 
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Table 40: Answers serial port settings field 

Offset Length Description 

0 1 Logical serial port number 

1 4 

Baud rate, supported rates: 

9,600 
19,200 
38,400 
57,600 
115,200 

5 1 Date size: 8 = 8-bit size 

6 1 

Parity: 

0 = None 

1 = Odd 

2 = Even 

7 1 
Stop bit: 

1 = 1 stop bit 

2 = 2 stop bits 

8 1 Flow control: 0 = None 

9 1 Modbus address: 1 through 247 

10 1 
Max. echoes per transactions. Used for the Get Detection command 
(function code 0x41), max. of 40 echoes. 

11 2 

Distance resolution: 

1 = m 
10 = dm 
100 = cm 
1,000 = mm 

NOTE: This answer table is repeated by the number of available serial port. 

 

Set serial port settings (function code 0x45, 0x01) 

Table 41, Table 42 and Table 43 present the requests and answers for the set serial port settings. 

 

Table 41: Requests header field 

Offset Length Description 

0 1 Sub-function code: 0x01 

 



 

Page 69 of 129  54A0028-6 042019 © LeddarTech Inc. 

Table 42: Requests serial port setting field 

Offset Length Description 

0 1 Settings of corresponding logical serial port number to set. 

1 4 

Baud rate, supported rates: 

9,600 
19,200 
38,400 
57,600 
115,200 

5 1 Date size: 8 = 8-bit size 

6 1 

Parity: 

0 = None 

1 = Odd 

2 = Even 

7 1 
Stop bit: 

1 = 1 stop bit 

2 = 2 stop bits 

8 1 Flow control: 0 = None 

9 1 Modbus address: 1 through 247 

10 1 
Max. echoes per transactions. Used for the Get Detection command 
(function code 0x41), max. of 40 echoes. 

11 2 

Distance resolution: 

1 = m 
10 = dm 
100 = cm 
1,000 = mm 

NOTE: This request table can be repeated by the number of available serial ports (by using the 
corresponding logical port number). 

 

Table 43: Answers 

Offset Length Description 

0 1 Sub-function code: 0x01 
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Get carrier firmware information (function code 0x45, 0x02) 

Table 44 and Table 45 present the registers for the firmware information commands. 

 

Table 44: Requests 

Offset Length Description 

0 1 Sub-function code: 0x02 

 

Table 45: Answers 

Offset Length Description 

0 1 Sub-function code: 0x02 

1 32 Firmware part number ASCII string 

33 8 Firmware version in four units for format A, B, C, and D. 

 

Get carrier device information (function code 0x45, 0x03) 

Table 46 and Table 47 present the registers for the carrier device information commands. 

 

Table 46: Requests 

Offset Length Description 

0 1 Sub-function code: 0x03 

 

Table 47: Answers 

Offset Length Description 

0 1 Sub-function code: 0x03 

1 32 Hardware part number ASCII string 

33 32 Hardware serial number ASCII string 

65 4 Option bits. For Leddar use 

 

Get CAN port settings (function code 0x45, 0x04) 

Table 48, Table 49 and Table 50 present the requests and answers of the get CAN port settings. 

Table 48: Requests 

Offset Length Description 

0 1 Sub-function code: 0x04 
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Table 49: Answers header field 

Offset Length Description 

0 1 Sub-function code: 0x04 

1 1 Number of CAN port 

 

Table 50: Answers CAN port settings field 

Offset Length Description 

0 1 Logical CAN port number settings 

1 4 

Baud rate, supported rates: 

• 10,000 

• 20,000 

• 50,000 

• 100,000 

• 125,000 

• 250,000 

• 500,000 

• 1,000,000 

5 1 
Frame format: 

0 = Standard 11 bits 

1 = Extended 29 bits 

6 4 Tx base ID 

10 4 Rx base ID 

14 1 
Maximum number of detections (measurements) 
returned per CAN detection message transaction: 1 
through 96 

15 2 

Distance resolution: 

• 1 = m 

• 10 = dm 

• 100 = cm 

• 1,000 = mm 

17 2 Inter-message delay 0 through 65535 milliseconds 

19 2 Inter-cycle delay 0 through 65535 milliseconds 

NOTE: This answer table is repeated by the number of available CAN port. 
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Set CAN port settings (function code 0x45, 0x05) 

Table 51 and Table 52 present the requests and answers for the CAN port commands. 

 

Table 51: Requests header field 

Offset Length Description 

0 1 Sub-function code: 0x05 

 

Table 52: Requests CAN port settings field 

Offset Length Description 

0 1 Settings of corresponding logical CAN port number to set 

1 4 

Baud rate, supported rates: 

10,000 
20,000 
50,000 
100,000 
125,000 
250,000 
500,000 
1,000,000 

5 1 

Frame format: 

0 = Standard 11 bits 

1 = Extended 29 bits 

6 4 Tx base ID 

10 4 Rx base ID 

14 1 
Maximum number of detections (measurements) returned per 
CAN detection message transaction: 1 through 96 

15 2 

Distance resolution: 

1 = m 
10 = dm 
100 = cm 
1,000 = mm 

17 2 Inter-message delay 0 through 65535 milliseconds 

19 2 Inter-cycle delay 0 through 65535 milliseconds 

NOTE: This request table can be repeated by the number of available CAN port (by using the 
corresponding logical port number). 
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Table 53: Answers 

Offset Length Description 

0 1 Sub-function code: 0x05 

 

5.5. CAN Bus Interface 

The CAN bus interface uses two default message IDs that can be modified by the user: 1856 
(0x740) and 1872 (0x750). 

Four message IDs are available: 

Table 54: CAN message IDs 

Message ID Direction Data Type 

0x740 Rx Request from a host 

0x750 Tx Answer to a host request 

0x751 Tx Number of detection messages 

0x752 and over Tx Detection messages 

 

1856 (0x740) (Rx base ID) 

These are 8-byte length messages for command requests that the module monitors: the first byte 
(Byte 0) describes the main function and the rest of the message bytes are used as arguments. 
Undescribed bytes are reserved and must be set to 0. 

The module answer messages are described in section 1872 (0x750) (Tx base ID). 
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Table 55: CAN bus request message 

Function Request 
(Byte 0) 

Function Request 
Description 

Function Arguments 
(Byte 1) 

1 
Stop sending detections 
continuously 

 

2 

Send detection once Bit field of operation mode 

Bit-0: 

0 = Return detection in single 
message mode 

1 = Return detection in multiple 
message mode 

3 

Start sending detections 
continuously (that is, the 
module will send a new set of 
detections each time they are 
ready without waiting for a 
request). 

Bit field of operation mode 

Bit-0: 

0 = Return detection in single 
message mode 

1 = Return detection in multiple 
message mode 

4 Get input data (read only) See Table 56 

5 Get holding data See Table 57 

6 Set holding data See Table 58 

7 Set base address See Table 59 

8 Read module data See Table 60 

9 Write module data See Table 61 

10 
Send module opcode 
command 

See Table 62 
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Table 56: CAN bus request message (Get input data) 

Input Data Type 
(Byte 1) 

Input Data Description 

0 Number of segments 

1 Device identification and option 

2 and 3 Firmware version 

4 and 5 Bootloader version 

6 FPGA version 

7 through 12 Serial number 

13 through 18 Device name 

19 through 24 Hardware part number 

25 through 30 Software part number 

 

 

Table 57: CAN bus request message (Get holding data) 

Holding Data Type 
(Byte 1) 

Holding Data Description 

0 Acquisition configuration 

1 Smoothing and detection threshold 

2 Light source power management 

3 Distance resolution and acquisition options 

4 CAN port configuration 1 

5 CAN port configuration 2 

6 CAN port configuration 3 

7 Reserved 

8 Segment enabled 
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Table 58: CAN bus request message (Set holding data)  

 

Holding 
Data Type 

(Byte 1) 

Holding Data 
Description 

Argument Argument Description 

0 

Acquisition 
configuration 

Byte 2 Exponent for the number of accumulation (that 
is, if the content of this register is n, 2n 
accumulations are performed). 

Byte 3 Exponent for the number of oversampling (that 
is, if the content of this register is n, 2n 
oversamplings are performed). 

Byte 4 Number of base samples 

1 

Smoothing 
and detection 
threshold 

Byte 2 Smoothing: Stabilizes the module 
measurements. The behavior of the 
smoothing algorithm can be adjusted by a 
value ranging from −16 to 16. Clear the 
Enable check box to disable smoothing. 

Bytes 4 
through 7 

Detection threshold as a fixed-point value with 
a 6-bit fractional part (that is, threshold value 
is this register divided by 64). 

2 

Light source 
power 
management 

Byte 2 Light source power in percentage of the 
maximum. A value above 100 is an error. If a 
value is specified that is not one of the 
predefined values, the closest predefined 
value will be used. Refer to the detection 
reading to verify the LED intensity value as 
seen in Table 55 and Table 67. 

Note that this value is ignored if the automatic 
light source intensity parameter is enabled. 

Byte 3 Number of echoes for saturation acceptance: 
the number of echoes can be saturated to 
avoid decreasing the light source power when 
using the automatic mode. 

Bytes 4 and 
5 

Auto light source power changes the delay in 
number of measurements 
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Holding 
Data Type 

(Byte 1) 

Holding Data 
Description 

Argument Argument Description 

3 

Distance 
resolution and 
acquisition 
options 

Bytes 2 and 
3 

Distance units: 

• 1 = m 

• 10 = dm 

• 100 = cm 

• 1,000 = mm 

Bytes 4 and 
5 

Bit field of acquisition options: 

Bit-0: Automatic light source power enabled 

Bit-1: Demerge object enabled 

Bit-2: Static noise removal enabled 

Bit-3: Precision (smoothing) enabled 

Bit-4: Saturation compensation enabled 

Bit-5: Overshoot management enabled 

Bit-6: Automatic light source power mode: 

0: Mode 1 

1: Mode 2 

Bit-7: Crosstalk Removal enabled 

Bit-8: Crosstalk Echo Removal enabled 

4 

CAN port 
configuration 
1 

Byte 2 Baud rate (kbps): 

0 = 1000 
1 = 500 
2 = 250 
3 = 125 
4 = 100 
5 = 50 
6 = 20 
7 = 10 

Byte 3 Frame format: 

0 = Standard 11 bits 

1 = Extended 29 bits 

Bytes 4 
through 7 

Tx base ID 

5 

CAN port 
configuration 
2 

Bytes 4 
through 7 

Rx base ID 

6 

CAN port 
configuration 
3 

Byte 3 Maximum number of detections 
(measurements) returned per CAN detection 
message transaction: 1 through 96 

Bytes 4 and 5 Inter-message delay 0 through 65535 
milliseconds 

Bytes 6 and 7 Inter-cycle delay 0 through 65535 milliseconds 
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7 Reserved - - 

8 
Segment 
enabled 

Bytes 4 
through 7 

Bit-field of the enabled segments 

 

Table 59: CAN bus request message (Set base address) 

Data 
Description 

Argument Argument Description 

Base address Bytes 4 
through 7 

Base address to access Read module date and Write module 
date commands (from 0x00000000 to 0x00FFFFFF) 

 

 

Table 60: CAN bus request message (Read module data) 

Data 
Description 

Argument Argument Description 

Read 
module data 

Byte 1 Data length (1, 2, or 4) 

Bytes 2 and 3 Offset from 0x0000 to 0xFFFF (final address to access is the 
result of the base address plus this offset). This function is an 
encapsulation of the SPI protocol. See section 5.1.3 Memory 
Map. 

 

 

Table 61: CAN bus request message (Write module data) 

Data 
Description 

Argument Argument Description 

Write module 
data 

Byte 1 Data length (1, 2, or 4) 

Bytes 2 and 3 Offset from 0x0000 to 0xFFFF (final address to access is the 
result of the base address plus this offset). 

Bytes 4 
through 7 

Data to write 

This function is an encapsulation of the SPI protocol. See 
section 5.1.3 Memory Map. 

 

 

Table 62: CAN bus request message (Send module opcode command) 

Data 
Description 

Argument Argument Description 

Send module 
opcode 

command 

Byte 2 Opcode 

This function is an encapsulation of the SPI protocol. See 
section 5.1.2 SPI Protocol. 

Byte 3 Optional argument (must be set to 0x00) 
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1872 (0x750) (Tx base ID) 

These are 8-byte answer messages to the host command requests. 

 

Table 63: CAN bus answer message 

Answer 
Data 

(Byte 0) 

Answer Data 
Description 

Additional Answer Data 
(Byte 1 to Byte 7) 

1 Answer to stop 
continuously sending 
detection requests. 

Success: Return echo from the command request. 

Fail: All bytes, from 2 through 7, are set to 0xFF. 

2 Answer to send once a 
detection request. 

Success: Return echo from the command request. 

Fail: All bytes, from 2 through 7, are set to 0xFF. 

3 Answer to continuously 
sending a detection 
request. 

Success: Return echo from the command request. 

Fail: All bytes, from 2 through 7, are set to 0xFF. 

4 Answer to the Get input 
data request. 

Success: See format in Table 64 

Fail: All bytes, from 2 through 7, are set to 0xFF. 

5 Answer to the Get 
holding data request. 

Success: See format in Table 58 

Fail: All bytes, from 2 through 7, are set to 0xFF. 

6 Answer to the Set 
holding data request. 

Success: Return echo of the command request. 

Fail: All bytes, from 2 through 7, are set to 0xFF. 

7 Answer to the Set base 
address request. 

Success: Return echo of the command request. 

Fail: All bytes, from 2 through 7, are set to 0xFF. 

8 Answer to the Read 
module data request. 

Success: See Table 65 

Fail: All bytes, from 2 through 7, are set to 0xFF. 

9 Answer to the Write 
module data request. 

Success: return echo of the command request. 

Fail: All bytes, from 2 through 7, are set to 0xFF. 

10 Answer to the Send 
module opcode request. 

Success: See Table 66 

Fail: All bytes, from 2 through 7, are set to 0xFF. 
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Table 64: CAN bus answer message (Get input data) 

Input Data 
Type 

(Byte 1) 

Input Data 
Description 

Argument Arguments Description 

0 
Number of 
segments 

Bytes 2 and 3 Number of segments 

1 

Device identification 
and options 

Bytes 2 and 3 Device identification code (13 for 
LeddarVu8) 

Bytes 4 through 7 Device option flags (LeddarTech 
internal use) 

2 

Firmware version in 
format A, B, C, D. 

Bytes 2 and 3 The firmware build version (A) 

Bytes 4 and 5 The firmware build version (B) 

Bytes 6 and 7 The firmware build version (C) 

3 
Firmware version in 
format A, B, C, D. 

Bytes 2 and 3 The firmware build version (D) 

4 

Bootloader version 
in format A, B, C, D. 

Bytes 2 and 3 The bootloader build version (A) 

Bytes 4 and 5 The bootloader build version (B) 

Bytes 6 and 7 The bootloader build version (C) 

5 
Bootloader version 
in format A, B, C, D. 

Bytes 2 and 3 The bootloader build version (D) 

6 

FPGA version Bytes 2 and 3 The FPGA version 

Byte 6 Run status 0: OFF, 0xFF: ON. 
Should always return 0xFF, 
otherwise the module is defective. 

7 through 12 
Serial number Bytes 2 through 7 Serial number as an ASCII string 

(max. 32 bytes) 

13 through 18 
Device name Bytes 2 through 7 The device name as an ASCII string 

(max. 32 bytes) 

19 through 24 
Hardware part 
number 

Bytes 2 through 7 The hardware part number as an 
ASCII string (max. 32 bytes) 

25 through 30 
Software part 
number 

Bytes 2 through 7 The software part number as an 
ASCII string (max. 32 bytes) 
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Table 65: CAN bus answer message (Read module data) 

Data Description Argument Argument Description 

Read module 
opcode command 

Byte 1 Data length (1, 2, or 4) 

Byte 2 
Offset 

Byte 3 

Byte 4 

Data to read 
Byte 5 

Byte 6 

Byte 7 
 

 

Table 66: CAN bus answer message (Send module opcode request) 

Data Description Argument Argument Description 

Send module 
opcode command 

Byte 2 Opcode 

Byte 3 Optional argument 

Byte 4 Optional return value 
 

1873 (0x751) (Tx base ID + 1) 

These are 8-byte messages that indicates the number of detections that will be sent. 

 

Table 67: CAN bus number of detection messages 

Data Data Return Description 

Byte 0 Number of detections 

Byte 1 Current light source power as a percentage of the maximum 

Byte 2 
Status of the bit field acquisition: Reserved 

Byte 3 

Bytes 4 through 7 
Timestamp of the acquisition. The timestamp is expressed as the 
number of milliseconds since the module was started. 
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1874 (0x752) (Tx base ID + 2) 

These are the detection messages with flag information, which contains one detection presented 
in the following format: 

• Data bytes 0 and 1 contain the distance in units defined by the distance­units holding data. 

• Data bytes 2 and 3 contain the amplitude. This value must be divided by 64 to get the 
amplitude (that is, 6 bits for fractional part). 

• Data bytes 4 and 5 contain the flag information as described in the table below. 

• Bytes 6 and 7 contain the segment number. 
 

 

Table 68: Flag information about measurements 

Data Description 

Bit 0 The detection is valid (always set). 

Bit 1 The detection is the result of object demerging. 

Bit 2 Reserved 

Bit 3 The detection is saturated. 

Bit 4-5 Reserved 

Bit 6 The detection within the crosstalk zone 

Bit 7-15  Reserved 
 

 

Detection messages can be sent in two modes: as a single message ID or a multiple message ID. 

For the single message ID mode, all detection messages are sequentially sent on the same 
message ID; that is, 1874 (0x752). 

For the multiple message ID mode, detections are send on a message IDs ranging from 1874 
through the number of detections (1874 + number of detections). The range of message IDs can 
be limited by the maximum number of detections to output to the CAN port (defined in CAN 
configuration 3 holding data for a maximum configurable of 96 detections). 

The following are examples of message IDs for the 1874 base (with a 19-detection frame): 

• From 1874 through 1893. 

• From 1874 through 1890, for a module setup with a maximum of 16 number of detections. 
 
 
 

For an example of a LeddarVu Can Bus, refer to Appendix C. 
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 Leddar™ Configurator 

Leddar™ Configurator provides configuration parameters and operation functionalities for 
LeddarTech products. 

6.1. Introduction to Configurator Software 

The Configurator interface can be resized manually or set to full screen view. 

All dialog boxes that do not include a selection of action buttons at the bottom, such as Connect, 
OK, Cancel, etc. are dockable at the top, the bottom, or on the right side of the main window. 

 

Figure 27: Raw Detections dialog box docked on the side of the main window 

When a dialog box or a window is already open a checkmark appears next to the command on the 
menu. 
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6.2. Connection Window 

The following is a description of the information shown in the Connection dialog box. 
 

  

Figure 28: USB connection dialog box          Figure 29: SPI connection dialog box 

 

 

Select a connection Type 

The connection type you are using. There are four connection types: 

1. IS16/M16/Evaluation Kit USB 
2. LeddarVu SPI 
3. LeddarVu USB/Serial 
4. LeddarOne  

Available ports 

The list of available ports displays the modules currently detected.  

 

NOTE: The next descriptions apply to IS16/M16/Evaluation Kit USB. 

Name 

The device name can be modified (see section 6.4.1 Module Name).  

Serial Number 

The serial number of the device as assigned by LeddarTech. 

Type 

The product name. 
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6.3. Leddar™ Configurator Main Window 

After connecting to the device, the main window opens. 

 

Figure 30: Leddar™ Configurator main window 

The measurements are plotted in a symbolic graph containing the 16 segments (white lines) 
originating from the LeddarVu module. Detections are drawn as arcs in their corresponding 
segments. Only valid measurements are displayed. A more detailed description of the 
measurements can be obtained in the Raw Detections dialog box (see section 6.12 Raw 
Detections). 

The X and Y numbers displayed at the bottom are the mouse cursor position coordinates. 

6.3.1. Toolbar 

The toolbar includes several buttons for adjusting the view of the main window display. 

6.3.2. Fit to Window 

Click the fit-to-window button  to adjust the LeddarVu module view to the main window. 

6.3.3. Force Equal Horizontal and Vertical Scales 

When the equal scaling button  is selected (button highlighted), the original ratio of the display 

is kept or restored. The horizontal and vertical scales will be set to the same values and the beam 

will be displayed in accordance with the beam properties (for example, the display will show a 47.5° 

beam for a 47.5° LeddarVu module). 

Click the button again to change the vertical and horizontal scales independently. 

Vertical scale 

setting areas 

Horizontal scale 

setting areas 
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NOTE: When in equal scaling mode, you cannot zoom the display horizontally or vertically, that is, 

holding the <Control> or <Shift> key down while zooming in or out will have no effect. The scales 

cannot then be modified by entering values in the fields shown in Figure 30 above. 

6.3.4. Zoom in 

Click the zoom in button  to zoom in vertically and horizontally around the center of the display. 

6.3.5. Zoom out 

Click the zoom out button  to zoom out vertically and horizontally around the center of the display. 

6.3.6. Scale 

The window opens with the default scale setting. The horizontal and vertical scales can be changed 

manually by entering new values in the fields accessible by clicking the areas shown in Figure 30. 

To apply the changes, click anywhere in the main window. 

6.3.7. Panning and Zooming 

The display in the main window can be panned and zoomed in different ways. Panning and zooming 

is done relative to the mouse cursor position. 

You can move up, down, and sideways by clicking and dragging the display. 

To zoom the display in and out, use the mouse wheel alone. This has the same effect as clicking 

the zoom in  or zoom out  button respectively (see sections 6.3.4 and 6.3.5). 

To zoom the display horizontally, hold down the <Control> key of the computer keyboard while 

using the mouse wheel. 

NOTE: The equal scaling button  must be not selected (not highlighted). 
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Figure 31: Zooming in (left) and out (right) horizontally 

To zoom the display vertically, hold the <Shift> key down while using the mouse wheel. 

NOTE: The equal scaling button  must be not selected (not highlighted). 

   

Figure 32: Zooming in (left) and out (right) vertically 

 

The measurements of a detection point appear as a pop-up when you point to it with the mouse 
cursor for a more accurate assessment of the detection. Detection points are shown in the form of 
green lines (arcs) in the main window for visibility reasons. 
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Figure 33: Detection point coordinates 

6.3.8. Changing the LeddarVu Module Origin 

The module origin can be modified by clicking the module origin at the bottom of the segments. 

To do so, use the mouse cursor to point to the bottom of the segments (a red dot appears); click 
and drag it in the desired position. 

 

Figure 34: Dot indicator to modify the module origin 
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If you click and drag the module origin, its position is displayed in the status bar as shown in 

Figure 35. 

 

Figure 35: Module position changed 

To apply the changes, click the apply button . 

The origin is saved in the module and it can also be modified by editing the parameters in the 
module position settings window. 

6.3.9. Changing the LeddarVu Module Orientation 

The module origin may be rotated to match its physical position. If you do so, the main window 
display can better match the physical installation of the module. For example, if the module is 
installed above the ground, the origin can be set to reflect its position. 

Use the mouse cursor to point to the top of the segments (the top turns red); click and drag it in 
the desired position. 
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Figure 36: Red bar to rotate the module position 

To apply the changes, click the apply button . 

The module orientation is saved in the module and can also be modified by editing the parameters 
in the module position settings window. 

6.4. Settings 

The LeddarVu module stores many settings. Once saved in the module, these parameters are 
effective at each power up. The Leddar™ Configurator software loads these parameters upon 
each connection. 
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6.4.1. Module Name 

When you connect to a LeddarVu module for the first time, it has a default name. You can change 
that name at any time. 

To change the module name: 

1. Connect to a module. 

2. On the Device menu, point to Configuration and click Device Name. 

 

Figure 37: Device menu and the Configuration menu items 

3. In the Device Name dialog box, in the Name field, type the new name of the module and click 
OK. 

 

Figure 38: Device Name dialog box 

4. To apply the change, click the apply button  in the Leddar™ Configurator main window. 
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6.4.2. Acquisition Settings 

The acquisition settings allow you to define parameters to use for detection and distance 
measurement. 

To open the Acquisition Settings dialog box, select Device > Configuration > Acquisition. 

  

Figure 39: Acquisition Settings dialog box 

To apply the changes, click the apply button  in the main window. 

Refer to Section 3.3 Acquisition Settings for more details on all the parameters. 

6.4.3. Serial Port 

The serial port settings of the USB, CAN and SERIAL board are configurable. 

To configure the serial port: 



 

Page 93 of 129  54A0028-6 042019 © LeddarTech Inc. 

1. On the Device menu, point to Configuration, point to Communication, and click Serial Ports. 

 

Figure 40: Device menu 

2. In the Serial Port Setting dialog box, use the arrows or type numbers to modify the values. 

 

Figure 41: Serial Port Settings dialog box 

 

Table 69 describes the serial port settings. 

 

Table 69: Serial port setting description 

Parameter Value 

Port number 

Select 1 for the configurable serial link number 1. 

Select 2 for the TTL serial link number 2. 

Select 3 for the USB VCP serial link. 

Baud rate 9,600 bps, 19,200 bps, 38,400 bps, 57,600 bps, 115,200 bps 

Address 1 to 247 

Detections 0 to 40 

Distance resolution Millimeters (mm), centimeters (cm), decimeters (dm), meters (m) 
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6.4.4. CAN Port 

The CAN port settings of the USB, CAN and SERIAL board are configurable. 

To configure the CAN port: 

1. On the Device menu, point to Configuration, point to Communication, and click CAN Ports. 

 

Figure 42: Device menu 

2. In the Serial Port Setting dialog box, use the arrows or type numbers to modify the values. 

 

Figure 43: CAN Port Settings dialog box 

Table 70 describes the CAN port settings. 
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Table 70: CAN port setting description 

Parameter Value 

Port number Select 1 for CAN communication 

Baud rate 
10,000 bps, 20,000 bps, 50,000 bps, 100,000 bps, 125,000 bps, 
250,000 bps, 500,000 bps, and 1,000,000 bps 

Base Tx ID 
The base CAN arbitration ID used for data messages coming from the 
USB, CAN and SERIAL to host (see the protocol documentation). 

Base Rx ID 
The base CAN arbitration ID used for data messages sent to the USB, 
CAN and SERIAL board (see the protocol documentation). 

Frame format Standard 11 bits, Extended 29 bits 

Inter-message delay 0 to 65535 milliseconds 

Inter-cycle delay 0 to 65535 milliseconds 

Detections 1 to 96 

Distance resolution Millimeters (mm), centimeters (cm), decimeters (dm), meters (m) 

 

6.5. Saving and Loading a Configuration 

The software configuration for a device can be saved to a file. This enables you to backup settings 
and restore them in case of system failure or in case you want to revert to earlier settings. You can 
also get the configuration that was stored with a record file. 

To save a configuration: 

- On the File menu, click Save Configuration. 

 

Figure 44: File menu 

To load a configuration: 

- On the File menu, click Load Configuration. 
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6.6. Configuring Detection Records 

Detection records provide a playback of detections recorded by a device. This visual information 
can be useful for verification, troubleshooting, or training purposes. Detection records allow for a 
full data playback stored in a *.ltl file that can later be reloaded and replayed.  

To configure the detection record: 

1. In Leddar™ Configurator, on the Settings menu, click Preferences. 

 

Figure 45: Settings menu 

2. In the Preferences dialog box, click Recording and click Recorder. 

 

Figure 46: Preferences dialog box 

3. Under Directory, click the Browse button to select the path where you want to save the 
detection record file. 

4. In the Maximum file size box, set the maximum file size by using the arrows or by entering the 
value manually. 

5. Under What, select the Log debug information check boxes. 

6. Under How Long, next to Maximum record time, determine the length of time for recording 
by using the arrows or by entering the value manually. At the end of that period, recording will 
stop even if the file size has not reached its maximum. 

7. Click OK to save the settings. 

 

A complete description of the elements found in the Preferences for recording dialog box follows 
the next two procedures. 

To start a recording: 



 

Page 97 of 129  54A0028-6 042019 © LeddarTech Inc. 

On the File menu, click Start Recording. 

 

Figure 47: File menu 

To stop a recording manually: 

On the File menu, click Stop Recording. 

 

Figure 48: File menu to stop a recording 

The following is a description of the elements available in the Preferences for recording dialog box. 

Record directory 

The record directory is the folder in which all record files will be saved. These files are in a 
proprietary format, with the extension *.ltl, and can only be opened and viewed with the Leddar™ 
Configurator software. 

Maximum file size 

Record files can be quite large. Set the maximum file size as needed. The recording stops for the 
current file once it reaches the maximum file size and automatically switches the recording to 
another file. This is to keep record files of manageable sizes.  

Debug 

These check boxes are reserved for the use of LeddarTech technicians. 

Maximum record time 

The value entered as the Maximum record time determines the length of the time for recording. 
At the end of that period, recording will stop even if the file size has not reached its maximum. 
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6.7. Using Detection Records 

Once you have completed a recording, you can review it and extract part of the recording. 

The Record Replay dialog box offers the same functions as a regular video player: there is a stop 
button, a play button, and frame-by-frame forward and backward buttons. 

The Position slider lets you move directly to a desired position. 

The Playback Speed slider lets you adjust the speed of the recording playback; faster is to the left. 

The Start, End, and Extract buttons allow you to select a portion of the recording and extract it for 
further reference or analysis. 

To play a record: 

1. If you are connected to a device, disconnect from the device. 

OR 

Open another Leddar™ Configurator main window. 

NOTE: The record files can also be opened by double-clicking them. 

2. On the File menu, click Replay. 

 

Figure 49: File menu to open a recording 

3. In the Record Replay dialog box, click the browse button to select a file. 

 

Figure 50: Record Replay dialog box 

4. Click the play button to start the playback. 

To extract a record file segment: 

Play 

button 



 

Page 99 of 129  54A0028-6 042019 © LeddarTech Inc. 

1. Set the Position slider to the position where you want the file segment to start and click the 
Start button. 

2. Set the Position slider to the position where you want the file segment to stop and click the 
End button. 

OR 

Play the record and stop it at a position of interest and then click the Start button; restart 
playing the record and stop it again at a position of interest and click the Stop button. 

3. Click the Extract button to extract and save that file segment. 

6.8. Data Logging 

The data logging function is used to output the data to a .txt file. This file can be imported in a software 
application, such as Microsoft Excel, for offline analysis. 

The duration of the record is indicated in the status bar. 

Each line of the generated text file contains the information related to a single detection. 

Table 71: Field description of the log text file 

Time (msec) Segment [0 15] Amplitude [0 512] Distance (m) Status 

12735204 7 0.9 33.61 1 
 

In this table, 

• Time indicates the timestamp of the detection from when the sensor was connected to 

the power supply. 

 

• Segment refers to the location of the detection (line, column). 

 

• Amplitude of the detection indicates the strength of the returned signal. 

 

• Distance indicates the distance of the detection in meters or in feet depending on the 

distance unit configured in the Preferences menu. 

 

• Status corresponds to a flag value. Refer to Section 6.1.2 Raw Detections for more 

details. 
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To use the data logging function: 

1. In Leddar™ Configurator, on the Settings menu, click Preferences. 

 

Figure 51: Settings menu 

2. In the Preferences dialog box, click Recording and click Data Logger. 

 

Figure 52: Preferences dialog box for logging data 

3. Under Directory, click the browse button to select the path where you want to save the log and 
click OK. 

4. On the File menu, click Start Data Logging. 

 

Figure 53: File menu 

5. To stop recording, on the File menu, click Stop Data Logging. 
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Figure 54: File menu to stop data recording 

A .txt file is saved in the selected directory. 

 

6.9. Firmware Update 

Follow the steps below to update the firmware. 

 

1. Connect the LeddarVu module to its power supply and to your computer by USB or SPI. 

2. Launch Leddar Configurator and connect to your sensor. 

3. You will get a prompt indicating that the carrier board firmware is outdated. 

 

 

Figure 55: Carrier board firmware update 

 

4. Follow the on-screen instructions to perform the firmware update. 

 

 

Figure 56: Carrier board firmware update warning 

NOTE: Remember to maintain the S3 button pressed while you press S1. See the image below. 
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For reference, here are the S3 and S1 buttons: 

 

Figure 57: Carrier board S3 and S1 buttons 

 

5. At the end of the update, you will have to power-cycle the sensor and connect again.  

6. Upon the second connection, you will get a prompt saying that the software is not up to date. 

 
 

 

 

 

 

 

 

 

Figure 58: Updating the latest version window 

 

7. Perform the second phase of the update, and power-cycle the sensor again.  

 

  

S3 

S1 
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To verify the update, on the View menu, click the State command. The Device State window 

opens, and you can verify the following versions. 

 

Figure 59: Device state window 

 

8. Once the update is done, you can create a backup of your sensor’s calibration and current 

acquisition settings. In the Device menu, click Action, Calibration Backup, and Create. 

 

 

 

  

 

 

 

 

Figure 60: Steps for creating a backup 

NOTE: A backup is made on all new sensors in the factory before shipping. 

 

 

Firmware version 

Carrier Board firmware 
version 

Validation of the 
calibration backup 
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6.10. Device State 

Information about a device is accessible when connecting to a device in the Connection window 
or by clicking the State command on the View menu. 

 

Figure 61: View menu 

The Device State window opens. 

 

Figure 62: Device State window 

General 

Timers & Load 
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This feature gives information in days, hours, minutes, and seconds about two types of activities of 
a device. The first line indicates the time elapsed since the last device reset, the second since the 
last power cut or outage. 

Measurement Rate 

This parameter indicates the rate at which the module measures the speed and dimension of static 
or moving surfaces. 

Automatic Parameter Values 

This parameter indicates the intensity of the light source. 

 

Device Information 

Serial Number 

This parameter indicates the serial number of the device as assigned by LeddarTech. 

Software Version 

This parameter indicates the software version, which is specific to the processor of your unit. 

Bootloader Version 

This parameter indicates the bootloader (booting instructions) version, which is specific to the 
processor of your unit. 

Asic Version 

This parameter indicates the version of the application-specific integrated circuit; the microchip 
designed for this special application. This field is optional in function of the receiver module type. 

FPGA Version 

This parameter indicates the field-programmable gate array circuit used in the device. 

Hardware Part Number 

This parameter indicates the hardware part number of the device as assigned by LeddarTech. 

Software Part Number 

This parameter indicates the software part number of the device as assigned by LeddarTech. 

Manufacturer Name 

This parameter indicates the name assigned to LeddarTech. 

Group Id Number 

This parameter indicates the end-user group unique identifier used for licensing purposes. 

 

Carrier 

Serial Number 
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This parameter indicates the serial number of the USB, CAN and SERIAL carrier board as assigned 
by LeddarTech. 

Software Version 

This parameter indicates the software version, which is specific to USB, CAN and SERIAL carrier 
board of your unit. 

Hardware Part Number 

This parameter indicates the hardware part number of the USB, CAN and SERIAL carrier board as 
assigned by LeddarTech. 

Software Part Number 

This parameter indicates the software part number of the USB, CAN and SERIAL carrier board as 
assigned by LeddarTech. 

 

6.11. Preferences 

Preferences are used to change various settings related to the display of Leddar™ Configurator.  

The Preferences dialog box is opened by clicking the Preferences command on the Settings 
menu. 

   

Figure 63: Settings Menu and Preferences Dialog Box 

Windows 

The two options allow the user to select how the content of the main window will be displayed in 
Leddar™ Configurator. Choices are: 

• The Restore window position and size on startup feature starts Leddar™ Configurator at 
the same place on the computer desktop and at the same size it was when it was closed. 

• The Restore window layout on connection feature connects to the Evaluation Kit at the 
same size it was and with all docked dialog boxes or windows that were displayed when it was 
closed. 

Distance 

The unit that is applied to distances displayed in Leddar™ Configurator. 
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Temperature 

The unit used when displaying the temperature. 

Recording 

The Recorder parameter lets you choose how data files are recorded. 

The Data Logger parameter lets you select a directory to store logs. 

Display 

The Detection Arc Thickness parameter allows a user to modify the pixel width of the displayed 
green detections arcs in the main window. 

 

6.12. Raw Detections 

The Raw Detections dialog box allows you to view detection values in many ways. It provides 
filters to isolate segments and detection parameters.. 

To open the Raw Detections dialog box, on the View menu, click Raw Detections. 

   

Figure 64: View menu and Raw Detections dialog box 
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Figure 65 presents an example of raw detections. When there is no detection in some segments, 
only the segments where a detection occurred appear in the list. 

 

Figure 65: Example of detection filters 

The following is a description of the parameters available in the Raw Detections dialog box. 

Min and Max Amplitude 

The value entered in the Min Amplitude box shows only detections of amplitude higher or equal 
to that value. For example, if the minimum amplitude is set to 5, only the detections of amplitude 5 
and more will be displayed. 

The value entered in the Max Amplitude box will show only detections of amplitude lower or equal 
to that value. For example, if the maximum amplitude is set to 8, only the detections of amplitude 
8 and lower will be displayed. 

Setting a value in both fields will result in a range of amplitude to display. 

Min and Max Distance 

The value entered in the Min Distance box will show only detections at a distance greater or equal 
to that value. For example, if the minimum distance is set to 10, only the detections at a distance 
of 10 and more will be displayed. 

The value entered in the Max Amplitude box will show only detections at a distance smaller or 
equal to that value. For example, if the minimum distance is set to 20, only the detections at a 
distance of 20 and less will be displayed. 

Setting a value in both fields will result in a range of distance to display. 

Boxes 1 to 8 

Check boxes 1 to 8 allow you to select which segments to display. 
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Freeze 

When selected, the Freeze parameter freezes the values displayed in the Raw Detections dialog box. 
To return to the live display, clear the check box. 

Seg 

The Seg column lists the segment for which there is a detection according to the filters used. The 
segment numbers are read from left to right starting at 1. 

Distance and Amplitude 

The Distance column displays the distance of the detection and the Amplitude column displays 
its amplitude. 

Flags 

The Flags column displays a number that represents a detection type. See Table 8 in section 4.1. 
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 Specifications 

This chapter presents the LeddarVu module specifications. 

7.1. General 

Table 72: General specifications 

Light Source pulse rate 51.2 kHz 

Photodetector array size 1 x 8 

Photodetector acquisition rate 100 MHz 

Measurement rate See Table 12. 

USB (optional) 2.0, 12 Mbits/s 

CAN (optional) 10 to 1000 kbit/s, optional 120- termination 

Serial links (optional) 
TTL, RS-232, RS-422, and RS-485. 2-wire, 4­wire, 
9600 to 115200 BPS 

Operating temperature -40°C to +85°C 

7.2. Mechanical 

Table 73: Mechanical specifications 

Assembly height 43.3 mm 

Assembly width 35.2 mm 
 

See section 7.6 for dimensions including optics. 

 

7.3. Electrical 

Table 74: Electrical specifications 

Voltage 12 VDC ± 0.6 V 

Power consumption (total) < 2.2 W 

Power output maximum current 15 mA 
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7.4. Optical 

Table 75: Optical specifications 

Wavelength 905 nm (infrared) 

Laser risk group IEC 60825-1:2014 (Third Edition); Class I laser product  

Beam width and height (HFOV and 
VFOV) 

 

Table 766. 

 

Table 76: HFOV and VFOV 

Horizontal FOV* Vertical FOV* 

16 ± 1° 0.3 ± 0.2° 

16 ± 1° 2.25 ± 0.6° 

47.5 ± 3.5° 0.3 ± 0.15° 

47.5 ± 3.5° 3 ± 0.6° 

98.5 ± 5° 0.3 ± 0.15° 

98.5 ± 5° 3 ± 0.25° 

 

* These parameters present the sensitivity of the module across the horizontal FOV (segment 

amplitude efficiency) and vertical FOV (amplitude vs. tilt). See Figure 66. 

 

 

Figure 66: Horizontal field of view (HFOV) and Vertical field of view (VFOV) 
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7.5. Performance 

Table 77: Module performances 

Performance Metrics Values  

Measurement accuracy ±5 cm 

Measurement precision 6 mm (amplitude >15) 

Resolution 1 cm 

Range (maximum light source intensity) 
Varies with beam optics and target properties 
(see amplitude vs range figures below) 

Data refresh rate Up to 100 Hz (standard board) 

 

 

Figure 67: 16° x 0.3° (maximum intensity, 256 accumulations, and 8 oversamplings) 
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Figure 68: 16° x 2.25° (maximum intensity, 256 accumulations, and 8 oversamplings) 

 

Figure 69: 47.5° x 0.3° (maximum intensity, 256 accumulations, and 8 oversamplings) 
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Figure 70: 47.5° x 3° (maximum intensity, 256 accumulations, and 8 oversamplings) 

 

Figure 71: 99.5° x 0.3° (maximum intensity, 256 accumulations, and 8 oversamplings) 
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Figure 72: 98.5° x 3° (maximum intensity, 256 accumulations, and 8 oversamplings) 
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7.6. Regulatory Compliance and Safety 

The module complies with FDA performance standards for laser products except for deviations 
pursuant to Laser Notice No. 50, dated June 24, 2007. 

NOTE: Testing results are valid for a cable length shorter than 3 meters. 

Table 78: Regulatory compliance 

Test Name Standard Test Specification Performance 
Criterion 

Result 

Radiated emissions 
FCC part 15 (2013) subpart B 

Class A 
30MHz-1GHz 

N/A Pass 

Radiated emissions 
CISPR11 (2009) A1 (2010) 

Group 1 - class A 
30MHz-1GHz 

N/A Pass 

Radiated emissions 
ICES-003 (2012) 

Class A 
30MHz-1GHz 

N/A Pass 

Electrostatic discharge immunity 
IEC61000-4-2 (2008) 

Contact: ±4 kV 
Air: ±8 kV 

C Pass 

Radiated electromagnetic field immunity 
IEC61000-4-3 (2006) 
A1 (2007) A2 (2010) 

80 MHz-1000M Hz: 10 V/m 
1.4 GHz – 2 GHz: 3 V/m 
2 GHz - 2.7 GHz: 1 V/m 

C Pass 
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7.7. Dimensions 

This section presents the LeddarVu module dimensions. 

7.7.1. 98.5° Module  

 

Figure 73: 98.5° module dimensions 
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7.7.2. 47.5° Module  

 

Figure 74: 47.5° module dimensions 
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7.7.3. 16° Module  

 

Figure 75: 16° module dimensions 
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 Technical Support 

For technical inquiries, please contact LeddarTech technical support by registering online at 
www.leddartech.com/support to easily: 

• Follow up on your requests 

• Find quick answers to questions 

• Get valuable updates 

Or by contacting us at: 

+ 1 418 653-9000 

+ 1 855 865-9900 

8:30 a.m. - 5:00 p.m. Eastern Standard Time 

To facilitate the support, please have in hand all relevant information such as part numbers, serial 
numbers. 

E-mail 

support@leddartech.com  

 

Company address 

LeddarTech Inc. 
4535, boul. Wilfrid-Hamel Blvd, #240 
Québec, QC  G1P 2J7 
Canada 

 

 

 

www.leddartech.com 

  

http://www.leddartech.com/support
mailto:support@leddartech.com
http://www.leddartech.com/
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Appendix A  ̶  Example of a 0x04 function (read 
input register) 

Transmitted message 

01 04 00 01 00 27 E1 D0 

Use the 0x04 command to read 39 consecutive registers starting at address 01. On device with 
Modbus address 01, using the CRC D0 E1. 

Received message 
 

01 04 4E 00 01 00 08 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 08 00 64 00 00 B0 F7 
00 00 00 0F 00 0E 00 0C 00 0D 00 0E 00 12 00 16 00 19 5A E3 5B F5 5E 26 62 29 63 92 75 13 
7C 2B 5B 66 00 01 00 01 00 01 00 01 00 01 00 09 00 09 00 01 66 6F 

1, 8, 0, 0, 0, 0, 0, 0, 0, 0, 8, 100, 0, 45303, 0, 15, 14, 12, 13, 14, 18, 22, 25, 23267, 23541, 24102, 
25129, 25490, 29971, 31787, 23398, 1, 1, 1, 1, 1, 9, 9, 1 

 

Header: 1, 8, 0, 0, 0, 0, 0, 0, 0, 0, 8, 100, 0, 45303, 0 

(Address 1) Status for polling mode: 1 = Detections ready 

(2) Number of segments: 8 = 8 segments 

(11) Number of detection: 8 = 8 detections 

(12) Light source power: 100 = 100% 

(14&15) TimeStamp: 45303 = 45303 ms 

 

Distance (first detection only): 15, 14, 12, 13, 14, 18, 22, 25 
(Address 16) Segment #8 = 15cm 

(17) Segment #7 = 14cm 

(18) Segment #6 = 12cm 

(19) Segment #5 = 13cm 

(20) Segment #4 = 14cm 

(21) Segment #3 = 18cm 

(22) Segment #2 = 22cm 

(23) Segment #1 = 25cm 
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Amplitude (first detection only): 23267, 23541, 24102, 25129, 25490, 29971, 31787, 

23398 
(Address 24) Segment #8 = 23267 / 64 = 363.55 counts 

(25) Segment #7 = 23541 / 64 = 367.83 counts 

(26) Segment #6 = 24102 / 64 = 376.59 counts 

(27) Segment #5 = 25129 / 64 = 392.64 counts 

(28) Segment #4 = 25490 / 64 = 398.28 counts 

(29) Segment #3 = 29971 / 64 = 468.30 counts 

(30) Segment #2 = 31787 / 64 = 496.67 counts 

(31) Segment #1 = 23398 / 64 = 365.59 counts 

 

Flag (first detection only): 1, 1, 1, 1, 1, 9, 9, 1 
(Address 32) Segment #8 = 1 = Valid 

(33) Segment #7 = 1 = Valid 

(34) Segment #6 = 1 = Valid 

(35) Segment #5 = 1 = Valid 

(36) Segment #4 = 1 = Valid 

(37) Segment #3 = 9 = Saturation 

(38) Segment #2 = 9 = Saturation 

(39) Segment #1 = 1 = Valid 
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Appendix B  ̶  Example of a 0x41 Modbus Function 

Transmitted data stream message 

01 41 C0 10 

Use the 0x41 command to read on device Modbus address # 01, using the CRC 10 C0. 

Received data stream message 

01 41 08 25 00 52 81 09 07 25 00 49 81 09 06 24 00 4F 81 09 05 25 00 05 81 09 04 29 00 A9 7D 
09 03 2E 00 96 66 01 02 35 00 CC 47 01 01 39 00 64 33 01 00 F0 4C 1A 00 64 00 00  D2 EE 

Get detection messages (first byte): 

Modbus address: 01 hex = 1 = Address#1 

Function code: 0x41 hex = 65 = function 0x41 

Number of detections: 08 hex = 8 = 8 detections 

Get detection messages (detection fields):  
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(1) 25 00 52 81 09 07: 
Distance (cm): 00 25 hex = 37cm = 0.37m 

Amplitude (count): 81 52 hex = 33106 / 64 = 517.28 counts 

Flag:  09 hex = 9 (Saturation) 

Segment #: 07 hex = 7 (Segment #8)  

 

(2) 25 00 49 81 09 06: 
Distance (cm): 00 25 hex = 37cm = 0.37m 

Amplitude (count): 81 49 hex = 33097 / 64 = 517.14 counts 

Flag:  09 hex = 9 (Saturation) 

Segment #: 06 hex = 6 (Segment #7)  

 

(3) 24 00 4F 81 09 05: 
Distance (cm): 00 24 hex = 36cm = 0.36m 

Amplitude (count): 81 4F hex = 33103 / 64 = 517.23 counts 

Flag:  09 hex = 9 (Saturation) 

Segment #: 05 hex = 5 (Segment #6)  

 

(4) 25 00 05 81 09 04: 
Distance (cm): 00 25 hex = 37cm = 0.37m 

Amplitude (count): 81 05 hex = 33029 / 64 = 516.08 counts 

Flag:  09 hex = 9 (Saturation) 

Segment #: 04 hex = 4 (Segment #5)  

 

(5) 29 00 A9 7D 09 03: 
Distance (cm): 00 29 hex = 41cm = 0.41m 

Amplitude (count): 7D A9 hex = 32169 / 64 = 502.64 counts 

Flag:  09 hex = 9 (Saturation) 

Segment #: 03 hex = 3 (Segment #4)  

 

(6) 2E 00 96 66 01 02: 

Distance (cm): 00 2E hex = 46cm = 0.46m 

Amplitude (count): 66 96 hex = 26262 / 64 = 410.34 counts 

Flag:  01 hex = 1 (Valid) 

Segment #: 02 hex = 2 (Segment #3)  

 

(7) 35 00 CC 47 01 01: 
Distance (cm): 00 35 hex = 53cm = 0.53m 
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Amplitude (count): 47 CC hex = 18380 / 64 = 287.19 counts 

Flag:  01 hex = 1 (Valid) 

Segment #: 01 hex = 1 (Segment #2)  

 

(8) 39 00 64 33 01 00: 
Distance (cm): 00 39 hex = 57cm = 0.57m 

Amplitude (count): 33 64 hex = 13156/ 64 = 205.56 counts 

Flag:  01 hex = 1 (Valid) 

Segment #: 00 hex = 0 (Segment #1)  

 

Get detection messages (trailing fields): 

(1) F0 4C 1A 00 64 00 00: 
TimeStamp (ms): 00 1A 4C F0 hex = 1 723 632 ms = 1723 s 

Light source POWER (%): 64 hex = 100 = 100% 

Bit field acq. (reserved):  00 00 hex = 0 

CRC (16bits Modbus) = EE D2 
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Appendix C  ̶  Example of a LeddarVu CAN Bus 
Detection Request 

A request is sent to the sensor, this request is an 8 bytes message that is addressed to the 
message ID 0x740, the sensor then replies with multiple 8 bytes message that is addressed to the 
message ID 0x750 +.  
 
There are two possible modes: 
 

1. For example, if we want to obtain a detection frame (polling), in the mode multiple message, 
we send this request: 0x740: 02, 01, 00, 00, 00, 00, 00, 00 

 

The sensor will then answer with the following sequence: 

0x750: 02 01 00 00 00 00 00 00: echo of the successful request 

0x751: 08 64 00 00 41 8D 26 00: number of detections (8), led power (100%), timestamp 
(2526529msec) 

0x752: 77 05 8F 00 01 00 07 00: detection of the channel #7, distance (0x0577 = 1399cm), 
amplitude (0x008F = 143/64 = 2.2344 counts), flag info (0x0001 = valid) 

0x753: 0E 05 D3 00 01 00 06 00: detection of the channel #6 

0x754: 05 05 EC 00 01 00 05 00: detection of the channel #5 

0x755: 03 05 F9 00 01 00 04 00: detection of the channel #4 

0x756: 0D 05 F2 00 01 00 03 00: detection of the channel #3 

0x757: 1B 05 ED 00 01 00 02 00: detection of the channel #2 

0x758: 2D 05 B9 00 01 00 01 00: detection of the channel #1 

0x759: 97 05 9F 00 01 00 00 00: detection of the channel #0 

 

2. If we want the sensor to send data streaming in the mode simple message, we initiate the 
communication with the request:  
0x740: 03, 00, 00, 00, 00, 00, 00, 00 

 

The sensor will then answer with the following sequence: 

0x750: 03 00 00 00 00 00 00 00: echo of the successful request 

0x751: 08 64 00 00 41 8D 26 00: detection frame N: number of detections (8), led power 
(100%), timestamp (2526529msec) 

0x752: 77 05 8F 00 01 00 07 00: detection of the channel #7, distance (0x0577 = 1399cm), 
amplitude (0x008F = 143/64 = 2.2344 counts), flag info (0x0001 = valid) 

0x752: 0E 05 D3 00 01 00 06 00: detection of the channel #6 

0x752: 05 05 EC 00 01 00 05 00: detection of the channel #5 

0x752: 03 05 F9 00 01 00 04 00: detection of the channel #4 

0x752: 0D 05 F2 00 01 00 03 00: detection of the channel #3 

0x752: 1B 05 ED 00 01 00 02 00: detection of the channel #2 

0x752: 2D 05 B9 00 01 00 01 00: detection of the channel #1 
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0x752: 97 05 9F 00 01 00 00 00: detection of the channel #0 

0x751: 08 64 00 00 41 8D 26 00: detection frame N+1  

0x752: 77 05 8F 00 01 00 07 00  

0x752: 0E 05 D3 00 01 00 06 00  

0x752: 05 05 EC 00 01 00 05 00  

0x752: 03 05 F9 00 01 00 04 00  

0x752: 0D 05 F2 00 01 00 03 00  

0x752: 1B 05 ED 00 01 00 02 00  

0x752: 2D 05 B9 00 01 00 01 00  

0x752: 97 05 9F 00 01 00 00 00 

0x751: 08 64 00 00 41 8D 26 00: detection frame N+2  

0x752: 77 05 8F 00 01 00 07 00  

0x752: 0E 05 D3 00 01 00 06 00  

0x752: 05 05 EC 00 01 00 05 00  

0x752: 03 05 F9 00 01 00 04 00  

0x752: 0D 05 F2 00 01 00 03 00  

0x752: 1B 05 ED 00 01 00 02 00  

0x752: 2D 05 B9 00 01 00 01 00  

0x752: 97 05 9F 00 01 00 00 00 

 

To stop the data streaming, we send the request: 

0x740: 01, 00, 00, 00, 00, 00, 00, 00 

 

The sensor the responds with the following message: 

0x750: 01 00 00 00 00 00 00 00: echo of the successful request 
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